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Safety information

Always follow basic safety precautions
when using this product to reduce risk of
injury from fire or electric shock.

1. Read and understand all instructions in
the documentation that comes with the
printer.

2. Observe all warnings and instructions
marked on the product.

3. Unplug this product from wall outlets
before cleaning.

4. Do not install or use this product near
water, or when you are wet.

5. Install the product securely on a stable
surface.

6. Install the product in a protected location
where no one can step on or trip over the
line cord, and the line cord cannot be
damaged.

7. If the product does not operate normally,
see Maintain the printer on page 18.

8. There are no user-serviceable parts
inside. Refer servicing to qualified service
personnel.
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1 Get started

This guide provides details about how to use the printer and how to resolve problems.

● Accessibility

● HP EcoSolutions (HP and the Environment)

● Understand the printer parts

● Select print paper

● Load paper

● Turn the printer off

● Update the printer

● Install the accessories

● Maintain the printer

● Open the HP printer software (Windows)

NOTE: If you are using the printer with a computer running Windows XP Starter Edition, Windows
Vista Starter Edition, Windows 7 Starter Edition, or Windows 8 Starter Edition, some features might
not be available. For more information, see System requirements on page 104.
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Accessibility
The printer provides a number of features that make it accessible for people with disabilities.

Visual

The HP software provided with the printer is accessible for users with visual impairments or low vision
by using your operating system's accessibility options and features. The software also supports most
assistive technology such as screen readers, Braille readers, and voice-to-text applications. For users
who are color blind, colored buttons and tabs used in the HP software have simple text or icon labels
that convey the appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed through keyboard
commands. The HP software also supports Windows accessibility options such as StickyKeys,
ToggleKeys, FilterKeys, and MouseKeys. The printer doors, buttons, paper trays, and paper guides
can be operated by users with limited strength and reach.

Support

For more details about the accessibility of this printer and HP's commitment to product accessibility,
visit HP's website at www.hp.com/accessibility.

For accessibility information for Mac OS X, visit the Apple website at www.apple.com/accessibility.
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HP EcoSolutions (HP and the Environment)
Hewlett-Packard is committed to helping you optimize your environmental footprint and empowering
you to print responsibly—at home or in the office.

For more detailed information about environmental guidelines HP follows during the manufacturing
process, see Environmental product stewardship program on page 120. For more information about
HP's environmental initiatives, visit www.hp.com/ecosolutions.

This section contains the following topics:

● Manage Power

● Optimize Printing Supplies

Manage Power
To conserve electricity, the printer comes with the following features:

Sleep mode

Power usage is reduced while in Sleep mode. After initial setup of printer, the printer will enter Sleep
mode after 5 minutes of inactivity.

To change the setting, complete the following steps:

1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Settings tab.

3. In the Power Management section, click Energy Save Mode and select the desired option.

4. Click Apply.

Auto Power-Off

Auto Power-Off is automatically enabled by default when you turn on the printer. When Auto Power-
Off is enabled, the printer will automatically turn off after 8 hours of inactivity to help reduce energy
use. Auto Power-Off is automatically disabled when the printer establishes a wireless or Ethernet (if
supported) network connection. You can change the Auto Power-Off setting from the printer software.
Once you change the setting, the printer will maintain the setting that you choose. Auto Power-Off
turns the printer off completely, so you must use the power button to turn the printer back on.

Windows: Open Toolbox. (For more information, see Open the Toolbox on page 153.) In the
Advanced Settings tab, click Change, and then select the preferred amount of time.

Mac OS X: Open HP Utility. (For more information, see HP Utility (Mac OS X) on page 154.) In the
Printer Settings section, click Power Management, and then select the preferred amount of time.

TIP: If you are printing through a wireless or Ethernet connection over a network, Auto Power-Off
should be disabled to ensure that print jobs do not get lost. Even when Auto Power-Off is disabled,
the printer will enter a Sleep mode after 5 minutes of inactivity to help reduce energy use.

NOTE: The printer's Sleep Mode and Auto Power-Off features are temporarily not available if one or
more of the ink cartridges are missing. After the cartridge is reinstalled, these features resume.

CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid
print quality issues and possible extra ink usage or damage to the ink system. Never turn off the
printer when ink cartridges are missing.
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Optimize Printing Supplies
To optimize printing supplies such as ink and paper, try the following:

● Recycle used original HP ink cartridges through HP Planet Partners. For more information, visit
www.hp.com/recycle.

● Optimize paper usage by printing on both sides of the paper. If the printer has an HP automatic
two-sided printing accessory (duplexer), see Print on both sides (duplexing) on page 32.
Otherwise, you can first print just the odd pages, flip the pages over, and then print just the even
pages.

● Save ink and paper when printing web content with HP Smart Print. For more information, visit
www.hp.com/go/smartprint.

● Change the print mode to a draft setting. The draft setting uses less ink.

● Do not clean the printhead unnecessarily. Doing so wastes ink and shortens the life of the
cartridges.
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Understand the printer parts
This section contains the following topics:

● Front view

● Printing supplies area

● Control panel

● Back view

Front view

1 Ink cartridge access door

2 Input tray

3 Paper guides

4 Tray extender

5 Output tray

6 Power button  and light

Printing supplies area

1 Ink cartridge access door

ENWW Understand the printer parts 5



2 Ink cartridges

3 Printhead assembly

NOTE: Printing supplies should be kept in the printer to prevent possible print quality issues or
printhead damage. Avoid removing supplies for extended periods of time. Do not turn off the printer
when a cartridge is missing.

Control panel
For more information, see Control panel lights reference on page 93.

1 ePrint button  and light

2 Ethernet light 

3 Wireless button  and light

4 Network Information button 

5 Cancel button 

6 Resume button  and light

7 Alert light 

8 Ink cartridge lights

9 Power button  and light

Back view

6 Chapter 1   Get started ENWW



1 USB port

2 Ethernet network port

3 Power input

4 Rear access panel
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Select print paper
The printer is designed to work well with most types of office paper. It is best to test a variety of print
paper types before buying large quantities. Use HP paper for optimum print quality. Visit the HP
website at www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday
documents. All papers with the ColorLok logo are independently tested to meet high
standards of reliability and print quality, and produce documents with crisp, vivid
color, bolder blacks, and that dry faster than ordinary plain papers. Look for papers
with the ColorLok logo in a variety of weights and sizes from major paper
manufacturers.

This section contains the following topics:

● Recommended papers for printing

● Recommended papers for photo printing

● Tips for selecting and using paper

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for
the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Brochure Paper

HP Professional Paper

HP Brochure and Flyer Paper

HP Tri-fold Brochure Paper

These papers are glossy-coated or matte-coated on both sides for two-sided use. They are
the perfect choice for producing professional quality marketing materials such as brochures
and mailers, as well as business graphics for report covers and calendars.

HP Premium Presentation
Paper

HP Professional Paper

These papers are heavy two-sided matte papers perfect for presentations, proposals,
reports, and newsletters. They are heavyweight for an impressive look and feel.

HP Bright White Inkjet Paper HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no showthrough, which makes it ideal for
newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder
blacks, and vivid colors.

HP Printing Paper HP Printing Paper is a high-quality multifunction paper. It produces documents that look
and feel more substantial than documents printed on standard multipurpose or copy paper.
It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

HP Office Paper HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts,
memos and other everyday documents. It features ColorLok Technology for less smearing,
bolder blacks, and vivid colors.

HP Office Recycled Paper HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled
fiber. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.
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HP Premium Plus Photo Paper HP's best photo paper is heavyweight for producing professional quality photos. Features
an instant-dry finish for easy handling without smudging. It resists water, smears,
fingerprints, and humidity. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x
15 cm (4 x 6 inch), 13 x 18 cm (5 x 7 inch), and two finishes – glossy or soft-gloss (satin
matte). It is acid-free for longer lasting documents.

HP Advanced Photo Paper This thick photo paper features an instant-dry finish for easy handling without smudging. It
resists water, smears, fingerprints, and humidity. Your prints have a look and feel
comparable to a store processed photo. It is available in several sizes, including A4, 8.5
x 11 inch, 10 x 15 cm (4 x 6 inch), 13x18 cm (5 x7 inch), A3, and two finishes – glossy or
soft-gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper Print colorful, everyday snapshots at a low cost, using paper designed for casual photo
printing. This affordable photo paper dries quickly for easy handling. Get sharp, crisp
images when you use this paper with any inkjet printer. Available in semi-gloss finish in 8.5
x 11 inch, A4, 4 x 6 inch, and 10 x 15 cm. It is acid-free for longer lasting documents.

To order HP papers and other supplies, go to www.hp.com. Go to Shop for Products & Services, and
select Ink & Toner.

NOTE: At this time, some portions of the HP website are available in English only.

Recommended papers for photo printing
For the best print quality, HP recommends using HP papers that are specifically designed for the type
of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Premium Plus Photo Paper HP's best photo paper is heavyweight for producing professional quality photos. Features
an instant-dry finish for easy handling without smudging. It resists water, smears,
fingerprints, and humidity. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x
15 cm (4 x 6 inch), 13 x 18 cm (5 x 7 inch), and two finishes – glossy or soft-gloss (satin
matte). It is acid-free for longer lasting documents.

HP Advanced Photo Paper This thick photo paper features an instant-dry finish for easy handling without smudging. It
resists water, smears, fingerprints, and humidity. Your prints have a look and feel
comparable to a store processed photo. It is available in several sizes, including A4, 8.5
x 11 inch, 10 x 15 cm (4 x 6 inch), 13x18 cm (5 x7 inch), A3, and two finishes – glossy or
soft-gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper Print colorful, everyday snapshots at a low cost, using paper designed for casual photo
printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp
images when you use this paper with any inkjet printer. Available in semi-gloss finish in 8.5
x 11 inch, A4, 4 x 6 inch, and 10 x 15 cm. It is acid-free for longer lasting documents.

HP Photo Value Packs HP Photo Value Packs conveniently package original HP ink cartridges and HP Advanced
Photo Paper to save you time and take the guesswork out of printing affordable, lab-quality
photos with your HP printer. Original HP inks and HP Advanced Photo Paper have been
designed to work together so your photos are long lasting and vivid, print after print. Great
for printing out an entire vacation's worth of photos or multiple prints to share.

To order HP papers and other supplies, go to www.hp.com. Go to Shop for Products & Services and
select Ink & Toner.

NOTE: At this time, some portions of the HP website are available in English only.
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Tips for selecting and using paper
For the best results, observe the following guidelines.

● Always use paper that conforms to the printer specifications. For more information, see Paper
specifications on page 105.

● Load only one type of paper at a time into a tray.

● When loading the trays, make sure the paper is loaded correctly. For more information, see
Load paper on page 11.

● Do not overload the tray. For more information, see Load paper on page 11.

● To prevent jams, poor print quality, and other printing problems, avoid loading the following
paper in the trays:

◦ Multipart forms

◦ Media that is damaged, curled, or wrinkled

◦ Media with cutouts or perforations

◦ Media that is heavily textured, embossed, or does not accept ink well

◦ Media that is too lightweight or stretches easily

◦ Media that contains staples or clips
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Load paper
This section provides instructions for loading paper into the printer.

● Load standard-size paper

● Load envelopes

● Load cards and photo paper

● Load custom-size paper

Load standard-size paper
Use these instructions to load standard–size paper.

1. Lift the output tray.

2. Slide the paper guides out as far as possible.

NOTE: If the paper is too long, pull the input tray to extend it.

3. Load the paper in portrait orientation and with the side to be printed facing down.

Make sure the stack of paper aligns with the right and back edges of the tray and does not
exceed the line marking in the tray.

NOTE: Do not load paper while the printer is printing.

4. Slide the paper guides in the tray to adjust them for the paper size that you have loaded.

5. Lower the output tray.

6. Pull out the output tray extension.
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Load envelopes
Use these instructions to load envelopes.

1. Lift the output tray.

2. Slide the paper guides out as far as possible.

3. Insert the envelopes print-side down and load according to the graphic.

Make sure the stack of envelopes does not exceed the line marking in the tray.

NOTE: Do not load paper envelopes while the printer is printing.

4. Slide the paper guides in the tray to adjust them for the envelope size that you have loaded.

5. Lower the output tray.

6. Pull out the output tray extension.

Load cards and photo paper
Use these instructions to load cards and photo paper.

1. Lift the output tray.

2. Slide the paper guides out as far as possible.

3. Insert the paper print-side down along the right edge of the main tray.

Make sure the stack of paper aligns with the right and back edges of the tray and does not
exceed the line marking in the tray. If the photo paper has a tab along one edge, make sure the
tab is pointing towards the front of the printer.

NOTE: Do not load cards or photo paper while the printer is printing.

4. Slide the paper guides in the tray to adjust them for the paper size that you have loaded.
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5. Lower the output tray.

6. Pull out the output tray extension.

Load custom-size paper
Use these instructions to load custom-size paper.

CAUTION: Use only custom-size paper that is supported by the printer. For more information, see
Paper specifications on page 105.

1. Lift the output tray.

2. Slide the paper guides out as far as possible.

3. Insert the paper print-side down along the right of the main tray.

Make sure the stack of paper aligns with the right and back edges of the tray, and does not
exceed the line marking in the tray.

NOTE: Do not load paper while the printer is printing.

4. Slide the paper guides in the tray to adjust them for the paper size that you have loaded.

5. Lower the output tray.

6. Pull out the output tray extension.
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Turn the printer off
Always turn off the printer by pressing the  (Power) button located on the printer. Wait until the
power light turns off before unplugging the power cord or turning off a power strip.

CAUTION: If you incorrectly turn the printer off, the print carriage might not return to the correct
position, causing printhead problems and print quality issues.

CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid
print quality issues, possible extra ink usage, or damage to the ink system. Never turn off the printer
when ink cartridges are missing.
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Update the printer
HP is always working to improve the performance of its printers and bring you the latest features. If
the printer is connected to a network and Web Services has been enabled, you can check for and
install printer updates.

To update the printer, complete the following steps:

1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Web Services tab.

3. In the Web Services Settings section, click Product Update, click Check Now, and follow the on-
screen instructions.

4. If the printer update option is not available, follow these instructions:

a. In the Web Services Settings section, click Setup, click Continue, and follow the on-screen
instructions.

b. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: If a printer update is available, the printer downloads and installs the update, and then
restarts.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-
screen instructions to set up a proxy server. If you do not have the details, contact your network
administrator or the person who set up the network.
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Install the accessories
This section contains the following topics:

● Install the automatic two-sided printing accessory (duplexer)

● Turn on accessories in the printer driver

Install the automatic two-sided printing accessory (duplexer)
You can print on both sides of a sheet of paper automatically. For information on using the duplexer,
see Print on both sides (duplexing) on page 32.

To install the duplexer:

Slide the duplexer into the back of the printer until the unit locks into place. Do not press the buttons
on either side of the duplexer when installing the unit; use them only for removing the unit from the
printer.

Turn on accessories in the printer driver
● To turn on accessories (Windows)

● To turn on accessories on (Mac OS X)

To turn on accessories (Windows)
1. Click Start, and then click Printers, Printers and Faxes, or Devices and Printers.

- Or -

Click Start, click Control Panel, and then double-click Printers.

- Or -

On the Start screen, click Control Panel, and then click View devices and printers.

2. Right-click the printer icon, and then click Properties.

3. Select the Device Settings tab. Click the accessory that you want to turn on, click Installed from
the drop-down menu, and then click OK.

To turn on accessories on (Mac OS X)
Mac OS X automatically turns on all accessories in the printer driver when you install the printer
software. If you add a new accessory later, follow these steps:
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1. Open the System Preferences and then select Print & Fax or Print & Scan.

2. Select the printer from list of printers, and then click Options & Supplies.

3. Click the Driver tab.

4. Select the options you want to install, and then click OK.
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Maintain the printer
This section provides instructions for keeping the printer in top working condition. Perform these
maintenance procedures as necessary.

● Clean the exterior

● Restore factory defaults

Clean the exterior 
WARNING! Before cleaning the printer, turn off the power and unplug the power cord from the
electrical socket.

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away
from the interior of the printer, as well as from the printer control panel.

Restore factory defaults
This section provides instructions about how to restore your printer back to the factory defaults.

▲ On the printer control panel, press and hold the  (Resume) button and the  (Wireless)
button , approximately five seconds, and then release the buttons.
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Open the HP printer software (Windows)
Open the HP printer software by doing one of the following:

● From the computer desktop, click Start, select Programs or All Programs, click HP, click the
folder for the printer, and then select the icon with the printer's name.

● On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, and
then click the icon with the printer's name.
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2 Print

Most print settings are automatically handled by the software application. Change the settings
manually only when you want to change print quality, print on specific types of paper, or use special
features. For more information, see Select print paper on page 8.

Choose a print job to continue:

Print documents on page 21

Print brochures on page 22

Print on envelopes on page 24

Print photos on page 26

Print on special and custom-sized
paper on page 28

Print borderless documents or photos
on page 30
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Print documents
Follow the instructions for your operating system.

● Print documents (Windows)

● Print documents (Mac OS X)

TIP:  This printer includes HP ePrint, a free service from HP that allows you to print documents on
your HP ePrint-enabled printer anytime, from any location, without any additional software or printer
drivers. For more information, see Use HP ePrint on page 39.

Print documents (Windows)
1. Load paper in the tray. For more information, see Load paper on page 11.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer, or Preferences.

5. Change the paper orientation on the Layout tab, and paper source, media type, paper size, and
quality settings on the Paper/Quality tab.

To print in black and white, click the Advanced button, and then select Black Ink Only from the
Print in Grayscale drop-down list under Printer Features.

6. Click OK.

7. Click Print or OK to begin printing.

Print documents (Mac OS X)
1. Load paper in the tray. For more information, see Load paper on page 11.

2. From the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected in the Format For pop-up menu.

If you do not see print options in the Print dialog, do the following:

● Mac OS X v10.6: Click the blue disclosure triangle next to the printer selection.

● OS X Lion: Click Show Details.

4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

5. Click Print.

ENWW Print documents 21



Print brochures
Follow the instructions for your operating system.

● Print brochures (Windows)

● Print brochures (Mac OS X)

TIP:  This printer includes HP ePrint, a free service from HP that allows you to print documents on
your HP ePrint-enabled printer anytime, from any location, without any additional software or printer
drivers. For more information, see Use HP ePrint on page 39.

Print brochures (Windows)
NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the
printer. For more information on the HP software, see Printer management tools on page 152.

1. Load paper in the tray. For more information, see Load paper on page 11.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer, or Preferences.

5. Change the paper orientation on the Layout tab, and paper source, media type, paper size, and
quality settings on the Paper/Quality tab.

To print in black and white, click the Advanced button, and then select Black Ink Only from the
Print in Grayscale drop-down list under Printer Features.

6. Click OK.

7. Click Print or OK to begin printing.

Print brochures (Mac OS X)
1. Load paper in the tray. For more information, see Load paper on page 11.

2. From the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected in the Format For pop-up menu.

If you do not see print options in the Print dialog, do the following:

● Mac OS X v10.6: Click the blue disclosure triangle next to the printer selection.

● OS X Lion: Click Show Details.

4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

5. Click Paper Type/Quality from the pop-up menu, and then select the following settings:
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● Paper Type: The appropriate brochure paper type

● Quality: Normal or Best

6. Select any other print settings that you want, and then click Print to begin printing.
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Print on envelopes
Avoid envelopes with the following characteristics:

● Very slick finish

● Self-stick adhesives, clasps, or windows

● Thick, irregular, or curled edges

● Areas that are wrinkled, torn, or otherwise damaged

Make sure the folds of envelopes you load in the printer are sharply creased.

NOTE: For more information about printing on envelopes, see the documentation available with the
software program you are using.

Follow the instructions for your operating system.

● Print on envelopes (Windows)

● Print on envelopes (Mac OS X)

Print on envelopes (Windows)
1. Load envelopes print-side down in the tray. For more information, see Load paper on page 11.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer, or Preferences.

5. On the Layout tab, change the orientation to Landscape.

6. Click Paper/Quality, and then select the appropriate envelope type from the Paper Size drop-
down list.

TIP: You can change more options for the print job by using the features available on the other
tabs in the dialog box.

7. Click OK, and then click Print or OK to begin printing.

Print on envelopes (Mac OS X)
1. Load envelopes print-side down in the tray. For more information, see Load paper on page 11.

2. From the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected in the Format For pop-up menu.

If you do not see print options in the Print dialog, do the following:

● Mac OS X v10.6: Click the blue disclosure triangle next to the printer selection.

● OS X Lion: Click Show Details.
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4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

5. Select the Orientation option.

6. Select any other print settings that you want, and then click Print to begin printing.
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Print photos
Do not leave unused photo paper in the input tray. The paper might start to curl, which could impair
the quality of your printout. Photo paper should be flat before printing.

Follow the instructions for your operating system.

● Print photos on photo paper (Windows)

● Print photos on photo paper (Mac OS X)

TIP: This printer includes HP ePrint, a free service from HP that allows you to print documents on
your HP ePrint-enabled printer anytime, from any location, and without any additional software or
printer drivers. For more information, see Use HP ePrint on page 39.

Print photos on photo paper (Windows)
1. Load paper in the tray. For more information, see Load paper on page 11.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the option that opens the printer Properties dialog box.

Depending on your software application, this option might be called Properties, Options, Printer
Setup, Printer, or Preferences.

5. On the Paper/Quality tab, select the appropriate photo paper type from the Media drop-down
menu.

NOTE: Maximum DPI is only supported for color printing on HP Premium Plus Photo Papers
and HP Advanced Photo Papers.

6. Click Advanced, and then select Best or Maximum DPI from the Output Quality drop-down
menu.

7. To print the photo in black and white, click the Print in Grayscale drop-down menu, and then
select one of the following options:

● High-Quality Grayscale: uses all the available colors to print your photo in grayscale. This
creates smooth and natural shades of gray.

8. Click OK, and then click Print or OK to begin printing.

Print photos on photo paper (Mac OS X)
1. Load photo paper print-side down in the tray. For more information, see Load paper on page 11.

2. From the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

If you do not see print options in the Print dialog, do the following.

● Mac OS X v10.6: Click the blue disclosure triangle next to the printer selection.

● OS X Lion: Click Show Details.
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4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

5. Click Paper Type/Quality from the pop-up menu, and then select the following settings:

● Paper Type: The appropriate photo paper type

● Quality: Best or Maximum dpi

6. If necessary, change the photo and color options:

a. Click the disclosure triangle beside Color Options and select the appropriate Photo Fix
options:

● Off: Applies no automatic adjustments to the image.

● Basic: Automatically focuses the image; moderately adjusts image sharpness.

b. To print the photo in black and white, click Grayscale from the Color pop-up menu, and
then select one of the following options:

● High Quality: Uses all the available colors to print your photo in grayscale. This creates
smooth and natural shades of gray.

7. Select any other print settings that you want, and then click Print to begin printing.
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Print on special and custom-sized paper
If your application supports custom-sized paper, set the size in the application before printing the
document. If not, set the size in the printer driver. You might need to reformat existing documents to
print them correctly on custom-sized paper.

Use only custom-sized paper that is supported by the printer. For more information, see Paper
specifications on page 105.

NOTE: Defining custom-sized paper sizes is only available in the HP printing software in Mac OS X.

● Print on special or custom-sized paper (Mac OS X)

● Set up custom sizes (Mac OS X)

Print on special or custom-sized paper (Mac OS X)
NOTE: Before you can print on custom-sized paper, you must set up the custom sizes in the HP
software provided with the printer. For instructions, see Set up custom sizes (Mac OS X)
on page 28.

1. Load the appropriate paper in the tray. For more information, see Load paper on page 11.

2. From the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected in the Format For pop-up menu.

If you do not see print options in the Print dialog, do the following:

● Mac OS X v10.6: Click the blue disclosure triangle next to the printer selection.

● OS X Lion: Click Show Details.

4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

5. Click Paper Handling from the pop-up menu.

6. Under Destination Paper Size, click Scale to fit paper size, and then select the custom size.

7. Select any other print settings that you want, and then click Print to begin printing.

Set up custom sizes (Mac OS X)
1. Load paper in the tray. For more information, see Load paper on page 11.

2. From the File menu in your software application, click Page Setup, and then make sure the
printer you want to use is selected in the Format For pop-up menu.

- OR -

From the File menu in your software application, click Print, and then make sure the printer you
want to use is selected.
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3. Select Manage Custom Sizes in the Paper Size pop-up menu.

NOTE: If you do not see these options in the Print dialog, click the disclosure triangle next to
the Printer pop-up menu or click Show Details.

4. Click the + on the left side of the screen, double-click Untitled, and type a name for the new
custom size.

5. In the Width and Height boxes, type the dimensions, and then set the margins, if you want to
customize them.

6. Click OK.
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Print borderless documents or photos
Borderless printing lets you print to the edges of certain photo media types and a range of standard
media sizes.

Before printing, open the file and make sure the size of the document or image matches the size of
the media loaded in the printer.

NOTE: Borderless printing is only available in some applications.

Follow the instructions for your operating system.

● Print borderless documents or photos (Windows)

● Print borderless documents or photos (Mac OS X)

Print borderless documents or photos (Windows)
1. Load paper in the tray. For more information, see Load paper on page 11.

2. On the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer, or Preferences.

5. Click the Paper/Quality tab, and then click the Advanced button.

6. In the Borderless Printing option, click Print Borderless, and then click the OK button.

7. In the Media drop-down list, select the appropriate paper type.

8. Click OK, and then click Print or OK to begin printing.

Print borderless documents or photos (Mac OS X)
1. Load paper in the tray. For more information, see Load paper on page 11.

2. From the File menu in your software application, click Print.

3. Make sure the printer you want to use is selected.

If you do not see print options in the Print dialog, do the following.

● Mac OS X v10.6: Click the blue disclosure triangle next to the printer selection.

● OS X Lion: Click Show Details.

4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

5. Click Paper Type/Quality from the pop-up menu, and then select the following settings:
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● Paper Type: The appropriate paper type

● Quality: Best or Maximum dpi

NOTE: If you do not see these options, click the disclosure triangle next to the Printer pop-up
menu or click Show Details.

6. Make sure the Print Borderless check box is selected.

7. If necessary, click the disclosure triangle beside Color Options and select the appropriate Photo
Fix options:

● Off: Applies no automatic adjustments to the image.

● Basic: Automatically focuses the image; moderately adjusts image sharpness.

8. Select any other print settings that you want, and then click Print to begin printing.
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Print on both sides (duplexing)
You can print on both sides of a sheet of media automatically by using the automatic two-sided
printing accessory (duplexer).

NOTE: Two-sided printing requires an automatic two-sided printing accessory (duplexer) to be
installed on the printer.

NOTE: You can perform manual duplexing by first printing only the odd pages, flipping the pages
over, and then printing only the even pages.

TIP: If the top and bottom margins in your document are smaller than 16 mm (0.63 inches), the
document might not print out correct.

● Perform two-sided printing (Windows)

● Perform two-sided printing (Mac OS X)

Perform two-sided printing (Windows)
1. Load the appropriate media. For more information, see Load paper on page 11.

2. Make sure the duplexer is installed correctly. For more information, see Install the automatic
two-sided printing accessory (duplexer) on page 16.

3. With a document open, click Print on the File menu, and then under the Print on Both Sides
options on the Layout tab, select either Flip on Long Edge or Flip on Short Edge.

4. Change any other settings, and then click OK.

5. Print your document.

Perform two-sided printing (Mac OS X)
1. Load the appropriate media. For more information, see Load paper on page 11.

2. Make sure the duplexer is installed correctly. For more information, see Install the automatic
two-sided printing accessory (duplexer) on page 16.

3. From the File menu in your software application, click Print.

4. Make sure the printer you want to use is selected in the Format For pop-up menu.

If you do not see print options in the Print dialog, do the following:

● Mac OS X v10.6: Click the blue disclosure triangle next to the printer selection.

● OS X Lion: Click Show Details.

5. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you
are done selecting the paper size, click OK to close Page Setup and return to the Print dialog.

6. Click the Layout pop-up menu, and then select the appropriate binding options for the document
from the Two-Sided pop-up menu.

7. Select any other print settings that you want, and then click Print to begin printing.
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Tips for print success
For good printing experience, HP ink cartridges should be correctly installed, have sufficient ink, and
working properly; and paper should be properly loaded with correct print settings.

Ink tips

● If the print quality is not acceptable, see Print quality troubleshooting on page 59 for more
information.

● Use original HP ink cartridges.

● Install both the black and color cartridges correctly.

For more information, see Replace the ink cartridges on page 45.

● Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

For more information, see Check the estimated ink levels on page 43.

● Always turn off the printer with  (the Power button) to allow the printer to protect the nozzles.

Paper loading tips

For more information, also see Load paper on page 11.

● Load a stack of paper (not just one page). All the paper in the stack should be of the same size
and type to avoid a paper jam.

● Load paper with the print-side down in the main tray.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the
guides do not bend the paper in the tray.

Printer settings tips (Windows)

● To change default print settings, click Set Preferences under Print, Scan & Fax in the HP printer
software.

For more information to open the printer software, see Open the HP printer software (Windows)
on page 19.

● To select the number of pages to print per sheet, on the Layout tab of the printer driver, select
the appropriate option from the Pages per Sheet drop-down list.

● If you want to change the page orientation, set it in your application interface.

● To view more printing settings, on the Layout or Paper/Quality tab of the printer driver, click the
Advanced button to open the Advanced Options dialog box.
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◦ Print in Grayscale: Allows you to print a black and white document using the black ink only.
Select Black Ink Only, and then click the OK button.

◦ Pages per Sheet Layout: Helps you specify the order of the pages if you print document in
more than two pages per sheet.

NOTE: The preview on the Layout tab cannot reflect what you select from the Pages per
Sheet Layout drop-down list.

◦ Borderless Printing: Select this feature to print photos without border. Not all paper types
support this feature. You will see an alert icon beside the option if the selected paper type
in the Media drop-down list does not support it.

◦ Preserve Layout: This feature only works with the duplex printing. If the image is larger than
the printable area, select this feature to scale the page content to be within the smaller
margins so that extra pages are not created.

◦ HP Real Life Technologies: This feature smooths and sharpens images and graphics for
improved print quality.

◦ Booklet: Allows you to print multiple-page document as a booklet. It places two pages on
each side of a sheet that can then be folded into a booklet in half size of the paper. Select a
binding method from the drop-down list, and then click OK.

● Booklet-LeftBinding: The binding side after folded into a booklet appears at the left
side. Select the option if your reading habit is from left to right.

● Booklet-RightBinding: The binding side after folded into a booklet appears at the right
side. Select the option if your reading habit is from right to left.

NOTE: The preview on the Layout tab cannot reflect what you select from the Booklet
drop-down list.

◦ Page Borders: Allows you to add the borders to the pages if you print the document with
two or more pages per sheet.

NOTE: The preview on the Layout tab cannot reflect what you select from the Page
Borders drop-down list.

● You can use printing shortcut to save setting time. A printing shortcut stores the setting values
that are appropriate for a particular kind of job, so that you can set all the options with a single
click. To use it, go to the Printing Shortcut tab, select one printing shortcut, and then click OK.

To add a new printing shortcut, after making settings on the Layout or Paper/Quality tab, click
the Printing Shortcut tab, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

NOTE: You cannot delete the default printing shortcuts.
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Printer settings tips (OS X)

● On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the
printer.

● On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate
paper type and quality.

● To print a black and white document using only black ink, choose the Paper Type/Quality from
the pop-up menu and choose Grayscale from the Color pop-up menu.

Notes

● Original HP ink cartridges are designed and tested with HP printers and papers to help you
easily produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or
repairs required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased original HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

● Ink level warnings and indicators provide estimates for planning purposes only.

NOTE: When you receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace the cartridges until print
quality becomes unacceptable.

● Software settings selected in the print driver only apply to printing, they do not apply to copying
or scanning.

● You can print your document on both sides of the paper.
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3 HP ePrint

HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer
anywhere you can send an email. Just send your documents and photos to the email address
assigned to your printer when you enable Web Services. No additional drivers or software are
needed.

Once you have signed up for an account on ePrintCenter (www.eprintcenter.com), you can sign in to
view your HP ePrint job status, manage your HP ePrint printer queue, control who can use your
printer's HP ePrint email address to print, and get help for HP ePrint.

NOTE: To use HP ePrint, the printer must be connected to an active network providing Internet
access. You cannot use these web features if the printer is connected using a USB cable.

This section contains the following topics:

● Set up HP ePrint

● Use HP ePrint

● Remove Web Services
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Set up HP ePrint
To set up HP ePrint, use one of the following methods:

NOTE: Before you set up HP ePrint, make sure your printer is connected using either an Ethernet or
wireless connection.

● Set up HP ePrint using the embedded web server

● Set up HP ePrint using the HP printer software

Set up HP ePrint using the embedded web server
You can use the printer embedded web server (EWS) to set up and manage HP ePrint.

To set up HP ePrint, complete the following steps:

1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Web Services tab.

3. In the Web Services Settings section, click Setup, click Continue, and follow the on-screen
instructions to accept the terms of use.

4. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: If a printer update is available, the printer downloads and installs the update, and then
restarts. Repeat the instructions from step 1 to set up HP ePrint.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-
screen instructions to set up a proxy server. If you do not have the proxy details, contact your
network administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the
instructions on the information page to finish the setup.

Set up HP ePrint using the HP printer software
If you do not set up HP ePrint when you installed the HP software on your computer, you can still use
the software to set up HP ePrint.

To set up HP ePrint, complete the following steps for your operating system:

Windows

1. Open the HP printer software. For more information, see Open the HP printer software
(Windows) on page 19.

2. In the window that appears, select Print, Scan & Fax, and then select ePrint Setup under Print.
The printer's embedded web server opens.

3. Click the Web Services tab.

4. In the Web Services Settings section, click Setup, click Continue, and follow the on-screen
instructions to accept the terms of use.
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5. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: If a printer update is available, the printer will download and install the update, and then
restart. You will have to repeat the instructions from step 1 to set up HP ePrint.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-
screen instructions to set up a proxy server. If you do not have the proxy details, contact your
network administrator or the person who set up the network.

6. When the printer is connected to the server, the printer prints an information page. Follow the
instructions on the information page to finish the setup.

Mac OS X

▲ To set up and manage Web Services in Mac OS X, you can use the printer's embedded web
server (EWS). For more information, see Set up HP ePrint using the embedded web server
on page 37.
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Use HP ePrint
To use HP ePrint, make sure to have the following:

● An Internet- and email-capable computer or mobile device

● An HP ePrint-capable printer on which Web Services has been enabled

TIP: For more information about managing and configuring HP ePrint settings and to learn about the
latest features, visit ePrintCenter (www.eprintcenter.com).

● Print using HP ePrint

● Find the printer's email address

● Turn off HP ePrint

Print using HP ePrint
To print documents using HP ePrint, complete the following steps:

1. On your computer or mobile device, open your email application.

NOTE: For information about using the email application on your computer or mobile device,
see the documentation provided with the application.

2. Create a new email message, and then attach the file that you want to print. For a list of files that
can be printed using HP ePrint, as well as guidelines to follow when using HP ePrint, see Set up
HP ePrint using the embedded web server on page 37.

3. Enter the printer's email address in the “To” line of the email message, and then select the
option to send the email message.

NOTE: The HP ePrint server does not accept email print jobs if there are multiple email
addresses included in the "To" or "Cc" fields. Only enter the email address of your HP printer in
the "To" field. Do not enter any additional email addresses in the other fields.

Find the printer's email address
NOTE: Make sure you have created an ePrint account.

To sign up for an account on ePrintCenter, visit ePrintCenter at www.eprintcenter.com.

To obtain the printer's email address, press the  (HP ePrint) button on the printer control panel.

The printer prints an information page that contains the printer email address.

Turn off HP ePrint
1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Web Services tab, and then click ePrint in the Web Services Settings section.

3. Click Turn Off ePrint.

NOTE: To remove all Web Services, see Remove Web Services on page 40.
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Remove Web Services
To remove Web Services, complete the following steps:

1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Web Services tab, and then click Remove Web Services in the Web Services Settings
section.

3. Click Remove Web Services.

4. Click Yes to remove Web Services from your printer.
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4 Work with ink cartridges

To ensure the best print quality from the printer, you need to perform some simple maintenance
procedures.

TIP: If you have problems printing documents, see Print quality troubleshooting on page 59.

This section contains the following topics:

● Information on ink cartridges and the printhead

● Check the estimated ink levels

● Printing with black or color ink only

● Replace the ink cartridges

● Store printing supplies

● Anonymous usage information storage
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Information on ink cartridges and the printhead
The following tips help maintain HP ink cartridges and ensure consistent print quality.

● The instructions in this user guide are for replacing ink cartridges, and are not intended for first
time installation.

CAUTION: While ink cartridges are not damaged when left outside of the printer, the printhead
does need to have all cartridges installed at all times after the printer is set up and in use.
Leaving one or more cartridge slots empty for an extended period may lead to print quality
problems and possibly damage the printhead. If you have recently left a cartridge out of the
printer for an extended period, or if you have had a recent paper jam, and have noticed poor
print quality, clean the printhead. For more information, see Clean the printhead on page 86.

● Keep all ink cartridges in the original sealed packages until they are needed.

● Be sure to turn off the printer properly. For more information, see Turn the printer off on page 14.

● Store ink cartridges at room temperature (15-35° C or 59-95° F).

● Always turn off the printer by pressing the  (Power) button. Wait until the Power light turns off
before unplugging the power cord or turning off a power strip. If you improperly turn off the
printer, the print carriage might not return to the correct position, and that can cause problems
with the printhead and print quality issues.

● Do not clean the printhead unnecessarily. This wastes ink and shortens the life of the cartridges.

● Handle ink cartridges carefully. Dropping, jarring, or rough handling during installation can cause
temporary printing problems.

● If you are transporting the printer, do the following to prevent ink leaking from the printer or other
damage from occurring to the printer:

◦ Make sure you turn off the printer by pressing the  (Power) button. Wait until all sounds of
internal motion stop before unplugging the printer. For more information, see Turn the
printer off on page 14.

◦ Make sure you leave the ink cartridges installed.

◦ Place the printer sitting flat in the box during packing. During transportation, the printer
should be stored in the same position (sitting flat) and should not be placed on its side,
back, front, or inverted.

Related topics

● Check the estimated ink levels on page 43

● Clean the printhead on page 86
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Check the estimated ink levels
You can check the estimated ink levels from the printer software. For information about using these
tools, see Printer management tools on page 152. You can also print the Printer Status page to view
this information (see Understand the Printer Status Report on page 81).

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you
receive a low-ink alert, consider having a replacement cartridge available to avoid possible printing
delays. You do not have to replace the cartridges until you are prompted.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used
in another printer, the ink level indicator might be inaccurate or unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways,
including in the initialization process, which prepares the printer and cartridges for printing, and in
printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some
residual ink is left in the cartridge after it is used. For more information, see www.hp.com/go/
inkusage.
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Printing with black or color ink only
For regular usage, this product is not designed to print using only the black cartridge when the color
cartridges are out of ink.

However, your printer is designed to let you print as long as possible when your cartridges start to run
out of ink.

When there is sufficient ink in the printhead, the printer will offer you the use of black ink only when
one or more of the color cartridges are out of ink, and the use of color ink only when the black
cartridge is out of ink.

● The amount that you can print using black or color ink only is limited, so have replacement ink
cartridges available when you are printing with black or color ink only.

● When there is no longer sufficient ink to print you will get a message that one or more cartridges
are depleted, and you will need to replace the depleted cartridges before you resume printing.

CAUTION: While ink cartridges are not damaged when left outside of the printer, the printhead does
need to have all cartridges installed at all times after the printer is set up and in use. Leaving one or
more cartridge slots empty for an extended period may lead to print quality problems and possibly
damage the printhead. If you have recently left a cartridge out of the printer for an extended period, or
if you have had a recent paper jam, and have noticed poor print quality, clean the printhead. For more
information, see Clean the printhead on page 86.
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Replace the ink cartridges
NOTE: For information on recycling used ink supplies, see HP inkjet supplies recycling program
on page 121.

If you do not already have replacement ink cartridges for the printer, see Order printing supplies
online on page 137.

NOTE: At this time, some portions of the HP website are available in English only.

NOTE: Not all cartridges are available in all countries/regions.

CAUTION: While ink cartridges are not damaged when left outside of the printer, the printhead does
need to have all cartridges installed at all times after the printer is set up and in use. Leaving one or
more cartridge slots empty for an extended period may lead to print quality problems and possibly
damage the printhead. If you have recently left a cartridge out of the printer for an extended period, or
if you have had a recent paper jam, and have noticed poor print quality, clean the printhead. For more
information, see Clean the printhead on page 86.

To replace the ink cartridges

Use these steps to replace the ink cartridges.

1. Make sure the printer is turned on.

2. Open the ink cartridge access door.

WARNING! Wait until the print carriage stops moving before proceeding.

3. Press the front of the ink cartridge to release it, and then remove it from the slot.

4. Remove the new ink cartridge from its packaging.
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5. Using the color-coded letters for help, slide the ink cartridge into the empty slot until it is securely
installed in the slot.

Make sure that you insert the ink cartridge into the slot that has the same colored letter as the
color you are installing.

6. Repeat steps 3 through 5 for each ink cartridge you are replacing.

7. Close the ink cartridge access door.

Related topics

● Order printing supplies online on page 137
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Store printing supplies
Ink cartridges can be left in the printer for extended periods of time. However, to assure optimal ink
cartridge health, be sure to turn off the printer properly. For more information, Turn the printer off
on page 14.
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Anonymous usage information storage
The HP cartridges used with this printer contain a memory chip that assists in the operation of the
printer. In addition, this memory chip stores a limited set of anonymous information about the usage
of the printer, which might include the following: the date when the cartridge was first installed, the
date when the cartridge was last used, the number of pages printed using the cartridge, the page
coverage, frequency of printing, the printing modes used, any printing errors that might have
occurred, and the printer model.

This information helps HP design future printers to meet our customers' printing needs. The data
collected from the cartridge memory chip does not contain information that can be used to identify a
customer or user of the cartridge or their printer.

HP collects a sampling of the memory chips from cartridges returned to HP's free return and recycling
program (HP Planet Partners: www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The
memory chips from this sampling are read and studied in order to improve future HP printers. HP
partners who assist in recycling this cartridge might have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can make this information
inaccessible by turning off the memory chip's ability to collect the printer's usage information.

To disable the usage information function

▲ On the printer control panel, press and hold the  (Resume) button and the  (Network
Information) button until the ink cartridge lights blink, approximately five seconds, and then
release the buttons.

NOTE: To re-enable the usage information function, open the embedded web server (EWS), click
the Settings tab, click the option that shows usage information or cartridge chip info in the
Preferences section, select the option to turn on, and then click Apply.

For more information about how to open the EWS, see Embedded web server on page 155.

NOTE: You can continue to use the cartridge in the HP printer if you turn off the memory chip's
ability to collect the printer's usage information.
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5 Solve a problem

The information in General troubleshooting tips and resources on page 53 suggests solutions to
common problems. If your printer is not operating correctly and those suggestions did not solve your
problem, try using the HP support services to obtain assistance.

This section contains the following topics:

● HP support

● General troubleshooting tips and resources

● Solve printer problems

● Print quality troubleshooting

● Solve paper-feed problems

● Solve problems using HP ePrint and HP websites

● Configure your firewall software to work with the printer

● Solve printer management problems

● Solve network problems

● Troubleshoot installation issues

● Understand the Printer Status Report

● Understand the network configuration page

● Printhead maintenance

● Uninstall and reinstall the HP software

● Clear jams

● Control panel lights reference
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HP support
If you have a problem, follow these steps

1. Check the documentation that came with the printer.

2. Visit the HP online support website at www.hp.com/support. This website provides information
and utilities that can help you correct many common printer problems. HP online support is
available to all HP customers. It is the fastest source for up-to-date printer information and
expert assistance and includes the following features:

● Fast access to qualified online support specialists

● HP software and driver updates for the HP printer

● Valuable troubleshooting information for common problems

● Proactive printer updates, support alerts, and HP news grams that are available when you
register the printer

For more information, see Obtain electronic support on page 50.

3. Call HP support. Support options and availability vary by printer, country/region, and language.
For more information, see HP support by phone on page 50.

● Obtain electronic support

● HP support by phone

Obtain electronic support
To find support and warranty information, go to the HP website at www.hp.com/support. This website
provides information and utilities that can help you correct many common printer problems. If
prompted, select your country/region, and then click Contact HP for information about calling for
technical support.

This website also offers technical support, drivers, supplies, ordering information and other options
such as:

● Access online support pages.

● Send HP an email message for answers to your questions.

● Connect with an HP technician by using online chat.

● Check for HP software updates.

You can also obtain support from the HP software for Windows or Mac OS X, which provide easy,
step-by-step solutions to common printing problems. For more information, see Printer management
tools on page 152.

Support options and availability vary by printer, country/region, and language.

HP support by phone
The phone support numbers and associated costs listed here are those in effect at time of publication
and are applicable only for calls made on a land line. Different rates may apply for mobile phones.
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For the most current HP list of telephone support numbers and call costs information, see
www.hp.com/support. This website provides information and utilities that can help you correct many
common printer problems.

During the warranty period, you may obtain assistance from the HP Customer Care Center.

NOTE: HP does not provide telephone support for Linux printing. All support is provided online at
the following website: https://launchpad.net/hplip. Click the Ask a question button to begin the support
process.

The HPLIP website does not provide support for Windows or Mac OS X. If you are using these
operating systems, see www.hp.com/support. This website provides information and utilities that can
help you correct many common printer problems.

This section contains the following topics:

● Before you call

● Phone support period

● Telephone support numbers

● After the phone support period

Before you call
Call HP support while you are in front of the computer and the printer. Be prepared to provide the
following information:

● Model number

● Serial number (located on the back or bottom of the printer)

● Messages that appear when the situation occurs

● Answers to these questions:

◦ Has this situation happened before?

◦ Can you re-create it?

◦ Did you add any new hardware or software to your computer at about the time that this
situation began?

◦ Did anything else occur prior to this situation (such as a thunderstorm or moving the
printer)?

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America (including
Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to
www.hp.com/support. Standard phone company charges apply.

Telephone support numbers
In many locations, HP provides toll free telephone support during the warranty period. However,
some of the support numbers might not be toll free.
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For the most current list of telephone support numbers, see www.hp.com/support. This website
provides information and utilities that can help you correct many common printer problems.

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be
available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call the
support phone number for your country/region to learn more about support options.

52 Chapter 5   Solve a problem ENWW

http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-001&h_page=hpcom&h_client=s-h-e008-1&h_product=5153793&h_lang=en&h_cc=us
http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-001&h_page=hpcom&h_client=s-h-e008-1&h_product=5153793&h_lang=en&h_cc=us


General troubleshooting tips and resources
NOTE: Many of the following steps require HP software. If you did not install the HP software, you
can install it using the HP software CD included with the printer, or download the HP software from
the HP support website, www.hp.com/support. This website provides information and utilities that can
help you correct many common printer problems.

Check or do the following before you begin troubleshooting:

● Try turning the printer off and then on again.

● For a paper jam, see Clear jams on page 90.

● For paper-feed problems, such as the paper skew and paper pick, see Solve paper-feed
problems on page 64.

● Power light is on and not blinking. When the printer is turned on for the first time, it takes
approximately 9 minutes to initialize it after the ink cartridges are installed.

● Power cord and other cables are working, and are firmly connected to the printer. Make sure the
printer is connected firmly to a functioning alternating current (AC) power outlet, and is turned
on. For voltage requirements, see Electrical specifications on page 111.

● Media is loaded correctly in the input tray and is not jammed in the printer.

● All packing tapes and materials are removed.

● The printer is set as the current or default printer. For Windows, set it as the default in the
Printers folder. For Mac OS X, set it as the default in the Print & Fax or Print & Scan section of
the System Preferences. See your computer's documentation for more information.

● Pause Printing is not selected if you are using a computer running Windows.

● You are not running too many programs when you are performing a task. Close programs that
you are not using or restart the computer before attempting the task again.
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Solve printer problems
TIP: You can visit the HP online support website at www.hp.com/support for information and utilities
that can help you correct many common printer problems.

This section contains the following topics:

● The printer shuts down unexpectedly

● Alignment fails

● The printer is not responding (nothing prints)

● The printer prints slowly

● The printer is making some unexpected noises

● Blank or partial page printed

● Something on the page is missing or incorrect

● Placement of the text or graphics is wrong

The printer shuts down unexpectedly

Check the power and power connections

● Make sure the printer is connected firmly to a functioning alternating current (AC) power outlet.
For voltage requirements, see Electrical specifications on page 111.

Alignment fails
If the alignment process fails, make sure you have loaded unused, plain white paper into the input
tray. The alignment fails when you have colored paper loaded in the input tray.

If the alignment process fails repeatedly, you may need to clean the printhead, or you might have
a defective sensor. To clean the printhead, see Clean the printhead on page 86.

If cleaning the printhead does not solve the problem, contact HP support. Go to www.hp.com/support.
This website provides information and utilities that can help you correct many common printer
problems. If prompted, select your country/region, and then click Contact HP for information on calling
for technical support.

The printer is not responding (nothing prints)

There are print jobs stuck in the print queue

● Open the print queue, cancel all documents, and then reboot the computer. Try to print after the
computer reboots. Refer to the Help system for the operating system for more information.

Check the printer setup

● For more information, see General troubleshooting tips and resources on page 53.
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Check the HP software installation

● If the printer is turned off when printing, an alert message should appear on your computer
screen; otherwise, the HP software provided with the printer might not be installed correctly. To
resolve this, uninstall the HP software completely, and then reinstall the HP software. For more
information, see Uninstall and reinstall the HP software on page 88.

Check the cable connections

● Make sure both ends of the USB cable or Ethernet cable are secure.

● If the printer is connected to a network, check the following:

◦ Check the Link light on the back of the printer.

◦ Make sure you are not using a phone cord to connect the printer.

Check any personal firewall software installed on the computer

● The personal software firewall is a security program that protects a computer from intrusion.
However, the firewall might block communication between the computer and the printer. If there
is a problem communicating with the printer, try temporarily disabling the firewall. If the problem
persists, the firewall is not the source of the communication problem. Re-enable the firewall.

The printer prints slowly
Try the following solutions if the printer is printing very slowly.

● Solution 1: Use a lower print quality setting

● Solution 2: Check the ink levels

● Solution 3: Contact HP support

Solution 1: Use a lower print quality setting
The print quality was set to a higher setting.

Check the print quality setting. Best and Maximum dpi provide the best quality but are slower than
Normal or Draft. Draft provides the fastest print speed.

If this did not solve the issue, try the next solution.

Solution 2: Check the ink levels
The ink cartridges might have insufficient ink. Insufficient ink may cause the printhead to overheat.
When the printhead overheats, the printer slows down to allow it to cool.

Check the estimated ink levels in the ink cartridges.

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you
receive a low-ink alert, consider having a replacement cartridge available to avoid possible printing
delays. You do not need to replace the ink cartridges until prompted to do so.
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CAUTION: While ink cartridges are not damaged when left outside of the printer, the printhead does
need to have all cartridges installed at all times after the printer is set up and in use. Leaving one or
more cartridge slots empty for an extended period may lead to print quality problems and possibly
damage the printhead. If you have recently left a cartridge out of the printer for an extended period, or
if you have had a recent paper jam, and have noticed poor print quality, clean the printhead. For more
information, see Clean the printhead on page 86.

For more information, see:

● Check the estimated ink levels on page 43

If this did not solve the issue, try the next solution.

Solution 3: Contact HP support
There was a problem with the printer.

Contact HP support for service.

Go to: www.hp.com/support. This website provides information and utilities that can help you correct
many common printer problems.

If prompted, choose your country/region, and then click Contact HP for information on calling for
technical support.

The printer is making some unexpected noises
You might hear some unexpected noises made by the printer. These are the servicing sounds when
the printer performs automatic servicing functions to maintain the health of the printheads.

NOTE: To prevent any potential damage to your printer:

Do not turn off the printer while the printer is performing any servicing. If you are turning off the
printer, wait for the printer to come to a complete stop before turning it off using the  (Power)
button. For more information, see Turn the printer off on page 14.

Make sure all ink cartridges are installed. If any of the ink cartridges are missing, the printer will
perform extra servicing to protect the printheads.

Blank or partial page printed

Clean the printhead

● Complete the printhead cleaning procedure. For more information, see Clean the printhead
on page 86. The printhead may need to be cleaned if the printer was turned off incorrectly.

NOTE: Incorrectly turning off the printer can cause print quality problems like blank or partial
pages. Printhead cleaning can solve these problems, but turning off the printer correctly can
prevent them in the first place. Always turn the printer off by pressing the  (Power) button on
the printer. Wait until the power light goes out before unplugging the power cord or turning off
a power strip.
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Check the paper settings

● Make sure you select the correct print quality settings in the printer driver for the paper loaded in
the trays.

● Make sure the page settings in the printer driver match the page size of paper loaded in the tray.

More than one page is being picked

● For more information, see Solve paper-feed problems on page 64.

There is a blank page in the file

● Check the file to make sure there is no blank page.

Something on the page is missing or incorrect

Check the Print Quality Diagnostic page

● Print a Print Quality Diagnostic page to help you decide whether to run any maintenance tools to
improve the print quality of your printouts. For more information, see Print quality troubleshooting
on page 59.

Check the margin settings

● Make sure the margin settings for the document do not exceed the printable area of the printer.
For more information, see Set minimum margins on page 108.

TIP: If the top and bottom margins in your document are smaller than 16 mm (0.63 inches), the
document might not print out correct.

Check the color print settings

● Make sure Print in Grayscale is not selected in the printer driver.

Check the printer location and length of USB cable

● High electromagnetic fields (such as those generated by USB cables) can sometimes cause
slight distortions to printouts. Move the printer away from the source of the electromagnetic
fields. Also, it is recommended that you use a USB cable that is less than 3 meters (9.8 feet)
long to minimize the effects of these electromagnetic fields.

Check the paper size

● Make sure the selected paper size matches the actual loaded paper size.

Placement of the text or graphics is wrong

Check how the paper is loaded

● Make sure the paper guides fit snugly against the edges of the stack of paper, and make sure
the tray is not overloaded. For more information, see Load paper on page 11.
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Check the paper size

● Content on a page might be cut off if the document size is larger than the paper that you are
using.

● Make sure the paper size selected in the printer driver matches the size of paper loaded in the
tray.

Check the margin settings

● If the text or graphics are cut off at the edges of the page, make sure the margin settings for the
document do not exceed the printable area of your printer. For more information, see Set
minimum margins on page 108.

Check the page-orientation setting

● Make sure the paper size and page orientation selected in the application match the settings in
the printer driver. For more information, see Change basic network settings on page 140.

Check the printer location and length of USB cable

● High electromagnetic fields (such as those generated by USB cables) can sometimes cause
slight distortions to printouts. Move the printer away from the source of the electromagnetic
fields. Also, it is recommended that you use a USB cable that is less than 3 meters (9.8 feet)
long to minimize the effects of these electromagnetic fields.

If the above solutions do not work, the problem may be caused by the inability of the application to
interpret print settings correctly. See the release notes for known software conflicts, refer to the
application's documentation, or contact the software manufacturer for specific help.

TIP: You can visit the HP online support website at www.hp.com/support for information and utilities
that can help you correct many common printer problems.
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Print quality troubleshooting
Try the solutions in this section to resolve print quality problems in your printout.

● Solution 1: Make sure you are using original HP ink cartridges

● Solution 2: Check the ink levels

● Solution 3: Check the paper loaded in the input tray

● Solution 4: Check the paper type

● Solution 5: Check the print settings

● Solution 6: Print and evaluate a print quality report

● Solution 7: Contact HP support

Solution 1: Make sure you are using original HP ink cartridges
Non-HP ink cartridges were being used.

Check to see if your ink cartridges are original HP ink cartridges.

HP recommends that you use original HP ink cartridges. Original HP ink cartridges are designed and
tested with HP printers to help you easily produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer service or repairs
required as a result of using a non-HP supply are not covered under warranty.

If you believe you purchased original HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

If this did not solve the issue, try the next solution.

Solution 2: Check the ink levels
The ink cartridges might have insufficient ink.

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you
receive a low-ink alert, consider having a replacement cartridge available to avoid possible printing
delays. You do not need to replace the ink cartridges until print quality becomes unacceptable.

CAUTION: While ink cartridges are not damaged when left outside of the printer, the printhead does
need to have all cartridges installed at all times after the printer is set up and in use. Leaving one or
more cartridge slots empty for an extended period may lead to print quality problems and possibly
damage the printhead. If you have recently left a cartridge out of the printer for an extended period, or
if you have had a recent paper jam, and have noticed poor print quality, clean the printhead. For more
information, see Clean the printhead on page 86.

Check the estimated ink levels in the ink cartridges. For more information, see Check the estimated
ink levels on page 43.

If this did not solve the issue, try the next solution.
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Solution 3: Check the paper loaded in the input tray
The paper was loaded incorrectly, or it was wrinkled or too thick.

Make sure the paper is loaded correctly and that it is not wrinkled or too thick.

● Load paper with the print side facing down. For example, if you are loading glossy photo paper,
load the paper with the glossy side down.

● Make sure the paper lays flat in the input tray and is not wrinkled. If the paper is too close to the
printhead during printing, the ink might be smeared. This can happen if the paper is raised,
wrinkled, or very thick, such as a mailing envelope.

For more information, see:

● Load paper on page 11

If this did not solve the issue, try the next solution.

Solution 4: Check the paper type
The wrong kind of paper was loaded in the input tray.

HP recommends that you use HP papers or any other paper type with ColorLok technology that is
appropriate for the printer. All papers with the ColorLok logo are independently tested to meet high
standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks
and dry faster than ordinary plain papers.

Always make sure the paper you are printing on is flat. For best results when printing images, use
HP Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a
cool, dry place. When you are ready to print, remove only the paper you plan to use immediately.
When you have finished printing, return any unused photo paper to the plastic bag. This prevents the
photo paper from curling.

NOTE: For this issue, there is not a problem with your ink supplies. Therefore, replacing the ink
cartridges is not necessary.

For more information, see:

● Select print paper on page 8

If this did not solve the issue, try the next solution.

Solution 5: Check the print settings
The print settings were set incorrectly.

Check the print settings.

● Check the print settings to see if the color settings are incorrect.

For example, check to see if the document is set to print in grayscale. Or, check to see if
advanced color settings such as saturation, brightness, or color tone, are set to modify the
appearance of colors.

● Check the print quality setting and make sure it matches the type of paper loaded in the printer.
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You might need to choose a lower print quality setting if colors are running into each other. Or,
choose a higher setting if you are printing a high-quality photo, and then make sure photo paper
such as HP Advanced Photo Paper is loaded in the input tray.

NOTE: On some computer screens, colors might appear differently than they do when printed on
paper. In this case, there is nothing wrong with the printer, print settings, or ink cartridges. No further
troubleshooting is required.

For more information, see:

● Select print paper on page 8

If this did not solve the issue, try the next solution.

Solution 6: Print and evaluate a print quality report
Print quality problems can have many causes: software settings, a poor image file, or the printing
system itself. If you are unhappy with the quality of your prints, a Print Quality Diagnostic page can
help you determine if the printing system is working correctly.

To print a print quality report

● Control panel: Press and hold the  (Power) button, press the  (Cancel) button seven times,
press the  (Resume) button two times, and then release the  (Power) button.

● Embedded web server: Click the Tools tab, click Print Quality Toolbox under Utilities, and then
click the Print Quality Report button.

● HP Utility (Mac OS X): In the Information And Support section, click Print Quality Diagnostics,
and then click Print.
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If defects are seen on the page, follow the steps below:

1. If the lines in Test Pattern 1 are not straight and connected, align the printer. For more
information, see Align the printhead on page 87.

2. If you see white lines in any of the color blocks in Test Pattern 2, clean the printhead. For more
information, see Clean the printhead on page 86.

3. If you see white or dark lines where the arrows are pointing in Test Pattern 3, align the printer.
For more information, see Align the printhead on page 87.

If there are no defects, then the printer and ink system are working properly. If you still see print
quality problems in your output, double-check your software settings and paper as described in the
previous solutions.

Solution 7: Contact HP support
There was a problem with the printer.
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Contact HP support for service.

Go to: www.hp.com/support. This website provides information and utilities that can help you correct
many common printer problems.

If prompted, choose your country/region, and then click Contact HP for information on calling for
technical support.
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Solve paper-feed problems
TIP: You can visit the HP online support website at www.hp.com/support for information and utilities
that can help you correct many common printer problems.

Paper is not supported for the printer or tray

● Use only paper that is supported for the printer and the tray being used. For more information,
see Paper specifications on page 105.

Paper is not picked up from a tray

● Make sure paper is loaded in the tray. For more information, see Load paper on page 11. Fan
the paper before loading.

● Make sure the paper guides are set to the correct markings in the tray for the paper size you are
loading. Also make sure the paper guides are snug, but not tight, against the stack.

● Make sure paper in the tray is not curled. Uncurl paper by bending it in the opposite direction of
the curl.

Media is not coming out correctly

● Make sure the output output tray extension is fully extended; otherwise, printed pages may fall
off the printer.

● Remove excess paper from the output tray. There is a limit to the number of sheets the tray can
hold.

Pages are skewing

● Make sure the paper loaded in the trays is aligned to the paper guides. If needed, pull out the
trays from the printer and reload the paper correctly, making sure that the paper guides are
aligned correctly.

● Load paper into the printer only when it is not printing.

● Remove and replace the automatic two-sided printing accessory (duplexer).

◦ Push the button on either side of the duplexer, and then remove the unit.
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◦ Reinsert the duplexer into the printer.

Multiple pages are being picked up

● Fan the paper before loading.

● Make sure the paper guides are set to the correct markings in the tray for the paper size you are
loading. Also make sure the paper guides are snug, but not tight, against the stack.

● Make sure the tray is not overloaded with paper.

● Use HP paper for optimum performance and efficiency.
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Solve problems using HP ePrint and HP websites
This section provides solutions to common problems using HP ePrint and HP websites.

● Solve problems using HP ePrint

● Solve problems using HP websites

Solve problems using HP ePrint
If you are having problems using HP ePrint, check the following:

● Make sure the printer is connected to the Internet using an Ethernet or wireless connection.

NOTE: You cannot use these web features if the printer is connected using a USB cable.

● Make sure the latest printer updates have been installed on the printer. For more information,
see Update the printer on page 15.

● Make sure HP ePrint is enabled on the embedded web server (EWS). For more information, see
Set up HP ePrint using the embedded web server on page 37.

● Make sure the network hub, switch, or router is turned on and working correctly.

● If you are connecting the printer using an Ethernet cable, make sure you are not connecting the
printer using a phone cord or a crossover cable to connect the printer to the network and that the
Ethernet cable is securely connected to the printer. For more information, see Solve Ethernet
network problems on page 71.

● If you are connecting the printer using a wireless connection, make sure the wireless network is
functioning properly. For more information, see Solve wireless problems on page 71.

● If you are using HP ePrint, check the following:

◦ Make sure the printer's email address is correct.

◦ Make sure that the printer's email address is the only address listed in the “To” line of the
email message. If other email addresses are listed in the “To” line, the attachments you are
sending might not print.

◦ Make sure you are sending documents that meet the HP ePrint requirements. For more
information, see HP ePrint specifications on page 110.

● If your network uses proxy settings when connecting to the Internet, make sure the proxy
settings you are entering are valid:

◦ Check the settings being used by the Web browser you are using (such as Internet
Explorer, Firefox, or Safari).

◦ Check with the IT administrator or person who set up your firewall.

If the proxy settings used by your firewall have changed, you must update these settings in
either the printer control panel. If these settings are not updated, you will not be able to use
HP ePrint.

For more information, see Set up HP ePrint using the embedded web server on page 37.
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TIP: For additional help on setting up and using HP ePrint, visit ePrintCenter
(www.eprintcenter.com).

Solve problems using HP websites
If you are having problems using HP websites from your computer, check the following:

● Make sure the computer that you are using is connected to the Internet.

● Make sure the web browser meets the minimum system requirements. For more information,
see HP website specifications on page 111.

● If your web browser uses any proxy settings to connect to the Internet, try turning off these
settings. For more information, see the documentation provided with your web browser.
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Configure your firewall software to work with the printer
A personal firewall, which is security software running on your computer, can block network
communication between your printer and your computer.

If you are having problems such as:

● Printer not found when installing HP software

● Unable to print, print job stuck in queue or printer goes offline

● Unable to see printer status on your computer

The firewall might be preventing your printer from notifying computers on your network where it can
be found.

If you are using the HP software on a computer running Windows and cannot find the printer during
installation (and you know the printer is on the network)—or if you have already successfully installed
HP software and experience problems—check the following:

● If you have just installed the HP software, try turning off your computer and the printer, and then
turning them both on again.

● Keep your security software up to date. Many security software vendors provide updates that
correct known issues and provide the latest defenses against new security threats.

● If your firewall has "High," "Medium," or "Low" security settings, use the "Medium" setting when
your computer is connected to your network.

● If you have changed any firewall settings from default, try going back to the default setting.

● If your firewall has a setting called "trusted zone," use this setting when your computer is
connected to your network.

● If your firewall has a setting to "not show alert messages," you should disable this. When
installing the HP software and using the HP printer you may see alert messages from your
firewall software that provide options to "allow," "permit" or "unblock." You should allow any HP
software that causes an alert. Also, if the alert has a "remember this action" or "create a rule for
this" selection, select it. This is how the firewall learns what can be trusted on your network.

● Do not have more than one firewall enabled at the same time on your computer. An example
would be having both the Windows firewall provided by the operating system and a third party
firewall enabled at the same time. Having more than one firewall enabled at the same time will
not make you computer any safer and may cause problems.

For more information about using your printer with personal firewall software, visit www.hp.com/go/
wirelessprinting, and then click Firewall Help in the Wireless Network Help section.

NOTE: At this time, some portions of this site are not available in all languages.
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Solve printer management problems
This section provides solutions to common problems that involve managing the printer. This section
contains the following topic:

● Embedded web server cannot be opened

NOTE: To use the embedded EWS, the printer must be connected to a network using either an
Ethernet or a wireless connection. You cannot use the embedded web server if the printer is
connected to a computer with a USB cable.

Embedded web server cannot be opened

Check your network setup

● Make sure you are not using a phone cord or a crossover cable to connect the printer to the
network.

● Make sure the network cable is securely connected to the printer.

● Make sure the network hub, switch, or router is turned on and working correctly.

Check the computer

● Make sure the computer that you are using is connected to the network.

NOTE: To use the EWS, the printer must be connected to a network using either an Ethernet or
a wireless connection. You cannot use the embedded web server if the printer is connected to
a computer with a USB cable.

Check your web browser

● Make sure the web browser meets the minimum system requirements. For more information,
see Embedded web server specifications on page 104.

● If your web browser uses any proxy settings to connect to the Internet, try turning off these
settings. For more information, see the documentation available with your web browser.

● Make sure JavaScript and cookies are enabled in your web browser. For more information, see
the documentation available with your web browser.

Check the printer IP address

● To check the IP address of the printer, obtain the IP address by printing a network configuration
page. Press the  (Network Information) button to print the network configuration page.

● Ping the printer using the IP address from the command prompt (Windows) or from Network
Utility (Mac OS X). (Network Utility is located in the Utilities folder in the Applications folder at the
top level of the hard disk.)

For example, if the IP address is 123.123.123.123, type the following at the command prompt
(Windows):

C:\Ping 123.123.123.123

Or
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In Network Utility (Mac OS X), click the Ping tab, type the 123.123.123.123 in the box, and then
click Ping.

If a reply appears, the IP address is correct. If a time-out response appears, the IP address is
incorrect.

TIP: You can visit the HP online support website at www.hp.com/support for information and utilities
that can help you correct many common printer problems.
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Solve network problems
This section provides solutions to common problems when you are unable to connect or use the
printer over your network.

This section contains the following topics:

● Solve Ethernet network problems

● Solve wireless problems

● Reset the Printer Network Settings

Solve Ethernet network problems
If you are unable to connect the printer to your Ethernet network, verify that:

● Make sure the Wireless light on the printer does not turn on.

● All cable connections to the computer and the printer are secure.

● The network is operational and the network hub, switch, or router is turned on.

● For computers running Windows, all applications, including virus protection programs, spyware
protection programs, and firewalls, are closed or disabled.

● The printer is installed on the same subnet as the computers that use the printer.

● If the installation program cannot discover the printer, print the network configuration page, and
enter the IP address manually in the installation program. For more information, see Understand
the network configuration page on page 83.

● Reinstall the HP software. For more information, see Uninstall and reinstall the HP software
on page 88.

Assigning the printer with a static IP address might resolve some installation problems, such as a
conflict with a personal firewall. (Not recommended)

TIP: You can visit the HP online support website at www.hp.com/support for information and utilities
that can help you correct many common printer problems.

Solve wireless problems
This section provides information about solving problems you might encounter when connecting the
printer to your wireless network.

Follow these suggestions in order, starting with those listed in the “Basic wireless troubleshooting”
section. If you still encounter problems, follow the suggestions provided in the “Advanced wireless
troubleshooting” section.

● Basic wireless troubleshooting

● Advanced wireless troubleshooting

● After resolving the problems

TIP: For more information about troubleshooting wireless problems, visit www.hp.com/go/
wirelessprinting.
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NOTE: After you resolve the problem, follow the instructions in After resolving the problems
on page 78.

Basic wireless troubleshooting
NOTE: If you have already configured the printer for wireless connection but the wireless light is still
blinking, restart components of the wireless network.

To restart the components, turn off the router and the printer, and then turn them back on in this
order: router first and then the printer. If you still are unable to connect, turn off the router, printer, and
your computer. Sometimes, turning off the power and then turning it back on recovers from a network
communication issue.

NOTE: If you have not configured the printer for wireless connection, use the HP software to
complete the setup. For more information, see Set up the printer using the embedded web server
(EWS) on page 145.

Perform the following steps in the order presented.

TIP: If you are using a computer running Windows, use the HP Print and Scan Doctor to help
diagnose and get assistance in installing and using HP printers on home network. To use this tool,
visit the HP Wireless Printing Center www.hp.com/go/wirelessprinting, and then click Print and Scan
Doctor in the Quick Links section.

Step 1 - Make sure the wireless (802.11) light is turned on

● The Wireless light in the printer control panel indicates the status of the wireless capabilities.

To turn on the printer wireless capabilities

Press the  (Wireless) button to turn on the printer wireless capabilities.

NOTE: If your printer supports Ethernet networking, make sure that an Ethernet cable has not
been connected to the printer. Connecting an Ethernet cable turns off the printer wireless
capabilities.

Light description/Light pattern Explanation

The Power light is on but the Wireless light is off. The wireless capabilities are turned off.

The Power light is on and the Wireless light is on but blinking. The wireless capabilities are turned on
but the printer is not connected to a
network.

The Power light is on and the Wireless light is on and solid. The wireless capabilities are turned on
but the printer is connected to a
network.
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Step 2 - Move the printer closer to the wireless router

● If you have configured the printer for wireless connection and the wireless light is solid, but the
printer still has trouble staying connected, or you have print or scan communication issues, try
moving the printer closer to the wireless router.

Step 3 - Run the Wireless Network Test

● For wireless networking issues, run the Wireless Network Test. If a problem is detected, the
printed test report includes recommendations that might help solve the problem. For more
information about how to print the wireless test page, see Test the wireless connection
on page 147.

Advanced wireless troubleshooting
If you have tried the suggestions provided in Basic wireless troubleshooting on page 72 and are still
unable to use the printer over the network with a computer or mobile devices for print, try the
following steps in the order presented:

● Step 1: Make sure your computer is connected to your network

● Step 2: Make sure that the printer is connected to your network

● Step 3: Make sure your computer is not connected over a Virtual Private Network (VPN)

● Step 4: Make sure the printer is online and ready

● Step 5: Make sure the HP printer labeled (Network) is set as the default printer driver (Windows
only)

● Step 6: Check to see if the firewall software is blocking communication

TIP: If you are using a computer running Windows, use the HP Print and Scan Doctor to help
diagnose and get assistance in installing and using HP printers on home network. To use this tool,
visit the HP Wireless Printing Center www.hp.com/go/wirelessprinting, and then click Print and Scan
Doctor in the Quick Links section.

Step 1: Make sure your computer is connected to your network

Make sure your computer is connected to your network—either the Ethernet network or the wireless
network. If the computer is not connected to the network, you cannot use the printer over the network.

To check an Ethernet connection

▲ Many computers have indicator lights beside the port where the Ethernet cable from the router
connects to your computer. Usually there are two indicator lights, one that is on and another that
blinks. If your computer has indicator lights, check to see if the indicator lights are on. If the lights
are not on, try reconnecting the Ethernet cable to the computer and the router. If you still do not
see lights, there might be a problem with the router, the Ethernet cable, or your computer.

NOTE: Mac computers do not have indicator lights. To check the Ethernet connection on
a Macintosh computer, click System Preferences in the Dock, and then click Network. If the
Ethernet connection is working correctly, Built-in Ethernet appears in the list of connections,
along with the IP address and other status information. If Built-in Ethernet does not appear in the
list, there might be a problem with the router, the Ethernet cable, or your computer. For more
information, click the Help button in the window.
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To check a wireless connection

1. Make sure that your computer's wireless has been turned on. (For more information, see the
documentation that came with your computer.)

2. If you are not using a unique network name (SSID), then it is possible that your wireless
computer could be connected to a nearby network that is not yours.

The following steps can help you determine if your computer is connected to your network.

Windows

a. From the computer desktop, click Start, click Control Panel, point to Network and Internet,
and then click View network status and tasks.

- Or -

From the computer desktop, click Start, select Settings, click Control Panel, double-click
Network Connections.

- Or -

Right-click an empty area on the Start screen, click All Apps on the app bar, click Control
Panel, click Network and Sharing Center, and then click View network status and tasks.

Leave the network dialog box open while you continue to the next step.

b. Disconnect the power cord from the wireless router. The connection status of your
computer should change to Not Connected.

c. Reconnect the power cord to the wireless router. The connection status should change to
Connected.

Mac OS X

▲ Click the AirPort icon in the menu bar at the top of the screen. From the menu that appears,
you can determine if the AirPort is turned on and which wireless network your computer is
connected to.

NOTE: For more detailed information about your AirPort connection, click System
Preferences in the Dock, and then click Network. If the wireless connection is working
correctly, a green dot appears next to AirPort in the list of connections. For more
information, click the Help button in the window.

If you are unable to get your computer connected to your network, contact the person who set up
your network or the router manufacturer as there might be a hardware issue with either your router or
computer.

TIP: If you are using a computer running Windows, use the HP Print and Scan Doctor to help
diagnose and get assistance in installing and using HP printers on home network. To use this tool,
visit the HP Wireless Printing Center www.hp.com/go/wirelessprinting, and then click Print and Scan
Doctor in the Quick Links section.

Step 2: Make sure that the printer is connected to your network

If your printer is not connected to the same network as your computer, you cannot use the printer
over the network. Follow the steps described in this section to find out if your printer is actively
connected to the correct network.
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NOTE: If your wireless router or Apple AirPort Base Station is using a hidden SSID, your printer
cannot automatically detect the network.

A: Make sure the printer is on the network

1. If the printer supports Ethernet networking and is connected to an Ethernet network, make sure
an Ethernet cable is not plugged into the back of the printer. If an Ethernet cable is plugged into
the back, then wireless connectivity is disabled.

2. If the printer is connected to a wireless network, run the Wireless Network Test. For more
information about how to print the wireless test page, see Test the wireless connection
on page 147.

3. After the page has been printed, check the wireless connection status, the Network Name
(SSID), and the IP address:

Connected The Connected is listed in the Connectivity area, the
Diagnostics Results section, which indicates if the printer
is connected to your network — either your Ethernet
network or your wireless network.

● If the Connected is Ready, the printer is actively
connected to a network.

● If the Connected is Offline, the printer is not
connected to a network.

Network Name (SSID) The Network Name (SSID) is listed in the Current
Configuration setction, which shows the network name
what your printer choose for connecting the wireless
network.

IP Address The IP Address is listed in the Current Configuration
section, which indicates your printer has the valid IP
address.

The IP address is the one used to open your printer's
embedded web server (EWS).

For information about connecting the printer to a wireless network, see Set up the printer using the
embedded web server (EWS) on page 145.

B: Check to see if you can access the EWS

▲ After you establish that the computer and the printer both have active connections to a network,
you can verify if they are on the same network by accessing the printer's EWS. For more
information, see Embedded web server on page 155.
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To access the EWS

a. On your computer, open the EWS. For more information, see Embedded web server
on page 155.

NOTE: If you are using a proxy server in your browser, you might need to disable it to
access the EWS.

b. If you can open the EWS, try using the printer over the network (such as to print) to see if
your network setup was successful.

If you cannot open the EWS or are still having problems using the printer over the network,
continue to the next section regarding firewalls.

C: Reconfigure wireless settings to make sure the connection is established

▲ If the printer is still not connected to your network, you need to reconfigure wireless settings in
HP printer software on the computer. For more information about the configuration, see Basic
wireless troubleshooting on page 72.

NOTE: Make sure an Ethernet cable is not plugged into the back of the printer. If it is plugged
into the back, then wireless connectivity is disabled.

Step 3: Make sure your computer is not connected over a Virtual Private Network (VPN)

A Virtual Private Network (VPN) is a computer network that uses the Internet to provide a remote,
secure connection to an organization's network. However, most VPN services do not allow you to
access local devices (like your printer) on your local network while your computer is connected to the
VPN.

To connect to the printer, disconnect from the VPN.

TIP: To use the printer while connected to the VPN, you can connect the printer to your computer
with a USB cable. The printer uses its USB and network connections at the same time.

For more information, contact your network administrator or the person who set up the wireless
network.

Step 4: Make sure the printer is online and ready

If you have the HP software installed, you can check the printer's status from your computer to see if
the printer is paused or offline, preventing you from using it.

To check the printer's status, complete the following steps:

Windows

1. Click Start, and then click Printers, Printers and Faxes, or Devices and Printers.

- Or -

Click Start, click Control Panel, and then double-click Printers.

- Or -

On the Start screen, click Control Panel, and then click View devices and printers.

2. If the printers on your computer are not being displayed in Details view, click the View menu,
and then click Details.
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3. Do one of the following, depending on the printer status:

a. If the printer is Offline, right-click the printer, and click Use Printer Online.

b. If the printer is Paused, right-click the printer, and click Resume Printing.

4. Try using the printer over the network.

Mac OS X

1. Click System Preferences in the Dock, and then click Print & Fax or Print & Scan.

2. Select the printer, and then click Open Print Queue.

3. If the print job is on hold, click Resume.

4. If the printer is paused, click Resume Printer.

If you can use the printer after performing the steps above but find that the symptoms persist as you
continue to use the printer, your firewall might be interfering.

If you still cannot use the printer over the network, continue to the next section for additional
troubleshooting help.

Step 5: Make sure the HP printer labeled (Network) is set as the default printer driver (Windows only)

If you install the HP software again, the installer might create a second version of the printer driver in
your Printers, Print & Fax, Devices and Printers, View devices and printers folder. If you have
difficulties printing or connecting to the printer, make sure the correct version of the printer driver is
set as the default.

1. Click Start, and then click Printers, Printers and Faxes, or Devices and Printers.

- Or -

Click Start, click Control Panel, and then double-click Printers.

- Or -

On the Start screen, click Control Panel, and then click View devices and printers.

2. Right-click the printer icon for the version of the printer driver that is connected wirelessly, and
select Set as Default Printer.

NOTE: If there is more than one icon in the folder for the printer, right-click the printer icon for the
version of the printer driver that is connected wirelessly, and select Set as Default Printer.

Step 6: Check to see if the firewall software is blocking communication

Temporarily turn off the firewall security software running on your computer, and then try to print,
scan, or fax to see if the communication is established.
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TIP: If you are using a computer running Windows, use the HP Print and Scan Doctor to help
diagnose and get assistance in installing and using HP printers on home network. To use this tool,
visit the HP Wireless Printing Center www.hp.com/go/wirelessprinting, and then click Print and Scan
Doctor in the Quick Links section.

Alternatively, the Firewall Help also provides the detailed information about firewall troubleshooting.
For more information, visit the HP Wireless Printing Center www.hp.com/go/wirelessprinting, and then
click Firewall Help in the Wireless Network Help section.

After resolving the problems
After you resolve any problems and have successfully connected the printer to your wireless network,
complete the following steps for your operating system:

Windows

1. On the computer desktop, click Start, select Programs or All Programs, click HP, select your
printer name, and then click Printer Setup & Software.

- Or -

On the Start screen, click Printer Setup & Software.

2. Click Connect a new printer, and then select the type of connection you want to use.

Mac OS X

1. Open HP Utility. For more information, see HP Utility (Mac OS X) on page 154.

2. Click the Applications icon on the HP Utility toolbar, double-click HP Setup Assistant, and then
follow the on-screen instructions.

Reset the Printer Network Settings

To reset the printer network settings, complete the following steps:

1. Press and hold the  (Wireless) button and the  (Cancel) button for three seconds.

2. Press the  (Network Information) button to print the network configuration page and verify that
the network settings have been reset. By default, the network name (SSID) is “HP-Print-**-
Officejet 7110”, where “** is a random number generated by the printer, and the communication
mode is "infrastructure."

NOTE: Previously configured wireless settings are removed after you reset the printer network
settings. You have to reconnect the printer to the wireless network using the Wireless Setup Wizard.
For more information, see Set up the printer using the embedded web server (EWS) on page 145.

TIP: You can visit the HP online support website at www.hp.com/support for information and utilities
that can help you correct many common printer problems.
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Troubleshoot installation issues
If the following topics do not help, see HP support on page 50 for information about HP support.

● Hardware installation suggestions

● HP software installation suggestions

Hardware installation suggestions

Check the printer

● Make sure that all packing tape and material have been removed from outside and inside the
printer.

● Make sure that the printer is loaded with paper.

● Make sure that no lights are on or blinking except the Power light, which should be on.

Check the hardware connections

● Make sure that any cords and cables that you are using are in good working order.

● Make sure that the power cord is connected securely to both the printer and to a working power
outlet.

Check the ink cartridges

● Make sure that all of the ink cartridges are firmly installed and aligned in their correct, color-
coded slot. A correctly installed ink cartridge should not move when pulled slightly. The printer
cannot work if all the ink cartridges are not installed.

HP software installation suggestions

Check the computer system

● Make sure that your computer is running one of the supported operating systems.

● Make sure that the computer meets at least the minimum system requirements.

● In Windows Device Manager, make sure that the USB drivers have not been disabled.

● If you are using a computer running Windows, and the computer cannot detect the printer, run
the uninstallation utility (util\ccc\uninstall.bat on the installation CD) to perform
a complete uninstallation of the printer driver. Restart your computer, and reinstall the printer
driver.

Verify installation preliminaries

● Make sure to use the installation CD that contains the correct HP software for your operating
system.

● Before installing HP software, make sure that all other programs are closed.
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● If the computer does not recognize the path to the CD-ROM drive that you type, make sure that
you are specifying the correct drive letter.

● If the computer cannot recognize the installation CD in the CD-ROM drive, inspect the
installation CD for damage. You can download the printer driver from the HP website
www.hp.com/support. This website provides information and utilities that can help you correct
many common printer problems.

NOTE: After correcting any problems, run the installation program again.
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Understand the Printer Status Report
Use the printer status report to view current printer information and ink cartridge status. Also use the
printer status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.

If you need to call HP, print the printer status report before calling.

To print the Printer Status Report

● Press and hold the  (Cancel) button for three seconds.

1. Product Information: Shows printer information (such as the printer name, model number, serial
number, and firmware version number), the accessories that are installed (such as the
duplexer), and the number of pages printed from the trays and accessories.

2. Print Usage Information: Shows summary information about pages printed from the printer.
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3. Ink Delivery System Information: Shows the estimated ink levels (represented in graphical form
as gauges) and the part numbers and Warranty expiration dates of the ink cartridges.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When
you receive a low-ink warning message, consider having a replacement cartridge available to
avoid possible printing delays. You do not need to replace cartridges until prompted to do so.

4. Additional Assistance: Shows where to find more help for using your printer.
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Understand the network configuration page
If the printer is connected to a network, you can print a network configuration page to view the
network settings for the printer and a list of networks detected by your printer. You can use the
network configuration page to help troubleshoot network connectivity problems. If you need to call
HP, it is often useful to print this page before calling.

To print the network configuration page from the printer control panel

● Press the  (Network Information) button to print the network configuration page.
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1. WPS PIN: Shows the WPS PIN for you to set up the printer on your wireless network using the
PIN Method.

2. General Information: Shows information about the current status and active connection type of
the network and other information, such as the URL of the embedded web server.

3. 802.3 Wired: Shows information about the active Ethernet network connection, such as the IP
address, subnet mask, default gateway, as well as the hardware address of the printer.
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4. 802.11 Wireless: Shows information about your wireless network connection, such as the host
name, IP address, subnet mask, default gateway, and server. It also indicates the network name
(SSID), the relative signal strengths and the channels being used. You can check the network
list to view if your own network signal strength is good and change the wireless communication
setup using embedded web server (EWS). For more information, see Set up the printer using
the embedded web server (EWS) on page 145.

5. Wireless Direct: Shows information about your Wireless Direct Printing connection, such as the
network name (SSID), IP address, subnet mask, default gateway, and server.

6. Miscellaneous: Shows information about more advanced network settings.

● Port 9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary
TCP/IP port on the printer is the default port for printing. It is accessed by HP software (for
example, the HP Standard Port).

● Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are
typically used on small networks for IP address and name resolution (through UDP port
5353), where a conventional DNS server is not used.

● SLP: Service Location Protocol (SLP) is an Internet standard network protocol that provides
a framework to allow networking applications to discover the existence, location, and
configuration of networked services in enterprise networks. This protocol simplifies
discovery and use of network resources such as printers, web servers, fax machines, video
cameras, files systems, backup devices (tape drives), databases, directories, mail servers,
calendars.

● Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery
(WS Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services
supported on the printer. Disable unused print services to prevent access through those
services.

NOTE: For more information about WS Discovery and WSD Print, visit
www.microsoft.com.

● IPP: Internet Printing Protocol (IPP) is a standard network protocol for remote printing.
Unlike other remote IP-based protocols, IPP supports access control, authentication, and
encryption, allowing for more secure printing.
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Printhead maintenance
If you are experiencing problems with printing, you might have a problem with the printhead. You
should perform the procedures in the following sections only when directed to do so for resolving print
quality issues.

Performing the aligning and cleaning procedures unnecessarily can waste ink and shorten the life of
the cartridges.

This section contains the following topics:

● Clean the printhead

● Align the printhead

Clean the printhead
If your printed output is streaked or has any incorrect or missing colors, the printhead might need to
be cleaned.

There are two stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and
uses an increasing amount of ink. After each stage, review the quality of the printed page. You should
only initiate the next phase of cleaning if the print quality is poor.

If print quality still seems poor after you complete both stages of cleaning, try aligning the printer. If
print quality problems persist after cleaning and aligning, contact HP support. For more information,
see HP support on page 50.

NOTE: Cleaning uses ink, so clean the printheads only when necessary. The cleaning process
takes a few minutes. Some noise might be generated in the process. Before cleaning the printheads,
make sure you load paper. For more information, see Load paper on page 11.

Not turning the printer off correctly can cause print quality problems. For more information, see Turn
the printer off on page 14.

To clean the printhead from the embedded web server (EWS)

1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.

3. Click Clean Printhead and follow the on-screen instructions.

To clean the printhead from Toolbox (Windows)

1. Load Letter, A4, or Legal unused plain white paper into the main input tray. For more
information, see Load standard-size paper on page 11.

2. Open Toolbox. For more information, see Open the Toolbox on page 153.

3. From the Device Services tab, click the icon to the left of Clean Printheads.

4. Follow the on-screen instructions.
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To clean the printhead from HP Utility (Mac OS X)

1. Open HP Utility. For more information, see HP Utility (Mac OS X) on page 154.

2. In the Information And Support section, click Clean Printheads.

3. Click Clean, and then follow the on-screen instructions.

Align the printhead
The printer automatically aligns the printhead during the initial setup.

You might want to use this feature when the printer status page shows streaking or white lines
through any of the blocks of color or if you are having print quality issues with your printouts.

To align the printhead from the printer control panel

1. Load letter, A4, or legal unused plain white paper into the main input tray.

2. On the printer control panel, press and hold the  (Power) button.

3. Press the  (Resume) button three times.

To align the printhead from the embedded web server (EWS)

1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Tools tab, and then click Print Quality Toolbox in the Utilities section.

3. Click Align Printer and follow the on-screen instructions.

To align the printhead from Toolbox (Windows)

1. Load Letter, A4, or Legal unused plain white paper into the main input tray. For more
information, see Load standard-size paper on page 11.

2. Open Toolbox. For more information, see Open the Toolbox on page 153.

3. From the Device Services tab, click the icon to the left of Align Printheads.

4. Follow the on-screen instructions.

To align the printhead from HP Utility (Mac OS X)

1. Open HP Utility. For more information, see HP Utility (Mac OS X) on page 154.

2. In the Information And Support section, click Align.

3. Click Align, and then follow the on-screen instructions.

ENWW Printhead maintenance 87



Uninstall and reinstall the HP software
If your installation is incomplete, or if you connected the USB cable to the computer before prompted
by the HP software installation screen, you might need to uninstall and then reinstall the HP software
that came with the printer. Do not simply delete the printer application files from your computer. Make
sure to remove them correctly using the uninstall utility provided when you installed the HP software.

To uninstall from a Windows computer, method 1

1. Disconnect the printer from your computer. Do not connect it to your computer until after you
have reinstalled the HP software.

2. On the computer desktop, click Start, select Programs or All Programs, click HP, click the printer
name, and then click Uninstall.

3. Follow the on-screen instructions.

4. If you are asked whether you would like to remove shared files, click No.

Other programs that use these files might not work correctly if the files are deleted.

5. Restart your computer.

6. To reinstall the HP software, insert the HP software CD into your computer's CD drive, and
follow the on-screen instructions.

7. Connect the printer when the HP software prompts you to connect it to the computer.

8. Press the  (Power) button to turn the printer on.

After connecting and turning on the printer, you might have to wait several minutes for all of the
Plug and Play events to complete.

9. Follow the on-screen instructions.

To uninstall from a Windows computer, method 2

NOTE: Use this method if Uninstall is not available in the Windows Start menu.

1. On the computer desktop, click Start, select Settings, click Control Panel, and then click Add/
Remove Programs.

- Or -

Click Start, click Control Panel, and then click Uninstall a Program or double-click Programs and
Features.

- Or -

On the Start screen, click Control Panel, and then click Uninstall a program.

2. Select the HP printer software, and then click Uninstall.

Follow the on-screen instructions.

3. Disconnect the printer from your computer.
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4. Restart your computer.

NOTE: It is important that you disconnect the printer before restarting your computer. Do not
connect the printer to your computer until after you have reinstalled the HP software.

5. Insert the HP software CD into your computer's CD drive and then start the Setup program.

6. Follow the on-screen instructions.

To uninstall from a Mac computer

1. Double-click the HP Uninstaller icon (located in the Hewlett-Packard folder in the Applications
folder at the top level of the hard disk), and then click Continue.

2. When prompted, type the correct administrator's name and password, and then click OK.

3. Follow the on-screen instructions.

4. When the HP Uninstaller finishes, restart your computer.
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Clear jams
Occasionally, paper becomes jammed during a job.

This section contains the following topics:

● Clear paper jams

● Avoid paper jams

Clear paper jams
CAUTION: To prevent possible damage to the printhead, clear paper jams as soon as possible.

TIP: If you notice poor print quality, clean the printhead. For more information, see Clean the
printhead on page 86.

To clear a jam

Use these steps to clear a paper jam.

1. Remove all papers from the output tray.

2. Push the handle on either side of the rear access panel (or duplexer,) and then pull the panel (or
duplexer) towards you.

CAUTION: Trying to clear a paper jam from the front of the printer can damage the print
mechanism. Always access and clear paper jams through the rear access panel.

3. Gently pull the paper out of the rollers.

CAUTION: If the paper tears when you are removing it from the rollers, check the rollers and
wheels for torn pieces of paper that might be remaining inside the printer. If you do not remove
all the pieces of paper from the printer, more paper jams are likely to occur.

4. Replace the rear access panel (or the duplexer). Gently push the door (or the duplexer) forward
until it snaps into place.

5. Check the front of the printer.

a. Open the ink cartridge access door.
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b. If there is paper remaining inside the printer, ensure the carriage has moved to the right of
the printer, free any paper scraps or wrinkled paper, and pull the paper towards you
through the top of the printer.

c. Move the carriage to the left, locate any jammed paper inside the printer on the right side of
the carriage, free any paper scraps or wrinkled paper, and pull the paper towards you
through the top of the printer.

WARNING! Do not reach into the printer when it is on and the carriage is stuck. When you
open the ink cartridge access door, the carriage should return to its position on the right side of
the printer. If it does not move to the right, turn off the printer before you remove any jam.

6. After clearing the jam, close all covers, turn on the printer (if you turned it off) and resend the
print job.

Avoid paper jams
To help avoid paper jams, follow these guidelines.

● Remove printed papers from the output tray frequently.

● Make sure that you are printing with paper that is not wrinkled, folded, or damaged.

ENWW Clear jams 91



● Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.

● Do not use paper that is too thick or too thin for the printer.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Make sure that the tray is loaded correctly and is not too full. For more information, see Load
paper on page 11.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper
in the input tray must be the same size and type.

● Adjust the paper guides in the input tray to fit snugly against all paper. Make sure the paper
guides does not bend the paper in the input tray.

● Do not force paper too far forward in the input tray.

● If you are printing on both sides of a page, do not print highly saturated images on light weight
paper.

● Use paper types that are recommended for the printer. For more information, see Paper
specifications on page 105.

● Make sure that the printer is clean.
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Control panel lights reference
The control panel lights indicate the status and are useful for diagnosing printing problems. This
section contains information about the lights, what they indicate, and what action to take if necessary.

For more information, visit the HP website www.hp.com/support for the latest troubleshooting
information, printer fixes, and updates. This website provides information and utilities that can help
you correct many common printer problems.

1 ePrint button  and light

2 Ethernet light 

3 Wireless button  and light

4 Network Information button 

5 Cancel button 

6 Resume button  and light

7 Alert light 

8 Ink cartridge lights

9 Power button  and light

Interpreting control panel lights

Light description/Light pattern Explanation and recommended action

All lights are off. The printer is off.

● Connect the power cable.

● Press the  (Power) button.

The Power light is on. The printer is ready.

● No action is required.
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Light description/Light pattern Explanation and recommended action

The Power light blinks. The printer is turning on or off, or is
processing a print job.

● No action is required.

The printer is pausing for the ink to dry.

● Wait for the ink to dry.

The Power light is on, and the Alert light and the Resume light blink. Print paper is jammed in the printer.

● Remove all paper from the output
tray. Locate and clear the jam. For
more information, see Clear jams
on page 90.

The paper width setting does not match
the paper loaded.

● Change the paper setting in the print
driver to match the paper loaded.
For more information, see Print on
special and custom-sized paper
on page 28

The printer is out of paper.

● Load paper and press the 
(Resume) button.

The printer carriage has stalled.

● Open the top cover and remove any
obstructions (such as jammed
paper).

● Press the  (Resume) button to
continue printing.

● If the error persists, turn the printer
off, and then on again.

The Power light is on and the Alert light blinks. A front cover, cleanout, duplexer, or jam
door is not closed completely.

● Make sure all covers are completely
closed.
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Light description/Light pattern Explanation and recommended action

The Power light is on, the Alert light blinks, and the ink cartridge lights blink one
after the other, from left to right.

The printhead is missing or faulty

● Turn off the printer, and then turn it
on again.

● If the error persists, contact
HP support for service or
replacement. For more information,
see HP support on page 50.

The Power light and the Alert light blink, and the ink cartridge lights blink one
after the other, from left to right.

● The printhead is incompatible.

◦ Turn off the printer, and then
turn it on again.

◦ If the error persists, contact
HP support for service or
replacement. For more
information, see HP support
on page 50.

● The ink cartridge is faulty, needs
attention, incorrect, or incompatible.

◦ Ensure the ink cartridge is
properly installed, and then try
to print. Remove and re-insert
the ink cartridge a few times if
necessary.

◦ If the error persists, replace the
ink cartridge.

The Power light is on, the Alert light and one or more of the ink cartridge lights
blink.

One or more of the ink cartridges are
missing.

● Install the indicated ink cartridge,
and then try to print. Remove and
re-insert the ink cartridge a few
times if necessary.

● If the error persists, replace the
indicated ink cartridge.

Ink level is depleted.

● Replace the indicated ink cartridge.
For ordering information, see
Supplies on page 138.

NOTE: You do not need to replace the
ink cartridges until you are prompted to.
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Light description/Light pattern Explanation and recommended action

The Power light is on and one or more of the ink cartridge lights are on. One or more of the ink cartridges are low
on ink and will need to be replaced soon.

NOTE: Ink level alerts and indicators
provide estimates for planning purposes
only. When you receive a low-ink alert,
consider having a replacement cartridge
available to avoid possible printing
delays.

The Power light is on, and the Resume light and one or more ink cartridge lights
blink.

One or more ink cartridges are out of ink.

● If the black ink cartridge or one or
more color ink cartridges are out of
ink, continue to print using the
remaining ink cartridges, but the
printer will print more slowly. Also,
the quality of printed documents
might be affected. For more
information, see Printing with black
or color ink only on page 44.

● If both the black ink cartridge and a
color ink cartridge are out of ink,
purchase new ink cartridges and
replace the depleted ones when
prompted to do so. For information
on how to install new cartridges, see
Replace the ink cartridges
on page 45.

One or more used, refilled, or counterfeit
ink cartridges are detected.

● Either replace the refilled or non-HP
cartridges with original HP ink
cartridges, or press the  (Resume)
button to continue using the
cartridge. For more information, see
Replace the ink cartridges
on page 45.

All lights blink. A non-recoverable error has occurred.
Unplug the power cord, and then plug the
power cord back in, and try printing.
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Light description/Light pattern Explanation and recommended action

The HP ePrint light is off. HP ePrint has not been set up.

● To set up HP ePrint, press the 
(HP ePrint) button, and then follow
the instructions on the information
page that prints.

HP ePrint has been set up but has been
turned off.

● To turn on HP ePrint, press the 
(HP ePrint) button.

HP ePrint is turned on but is unable to
connect.

● HP ePrint is unable to connect,
possibly because the server is
unavailable or the network is not
functioning properly.

If your network uses proxy settings
when connecting to the Internet,
make sure the proxy settings you
are entering are valid. For more
information, see the getting started
guide provided with the printer or
check with the IT administrator or
person who set up your network.

Press the  (HP ePrint) button to
try connecting again.

◦ If the printer can connect, the
HP ePrint light turns on, and
the printer prints an information
page.

◦ If the printer still cannot
connect, the HP ePrint light
blinks and then turns off, and
the printer prints an information
page.

HP ePrint has been set up but has been
turned off because the printer has not
been updated.

● If a mandatory update for the printer
is available but has not been
installed, HP ePrint is turned off.
After the update has been installed,
HP ePrint turns on automatically.

For more information about
installing the printer update, press
the  (HP ePrint) button.

ENWW Control panel lights reference 97



Light description/Light pattern Explanation and recommended action

The HP ePrint light is on. HP ePrint is turned on.

If you press the  (HP ePrint) button
once, the printer prints an information
page that includes the email address you
will use for printing documents using HP
ePrint.

To turn off HP ePrint, press and hold the
 (HP ePrint) button. The light blinks for

five seconds before turning off.

The HP ePrint light blinks. HP ePrint is trying to connect.

The HP ePrint light blinks when you turn
on or turn off HP ePrint.

If HP ePrint is able to connect
successfully, the light blinks and then
turns on. If HP ePrint cannot connect, the
light blinks and then turns off.
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A Technical information

This section contains the following topics:

● Warranty information

● Printer specifications

● Regulatory information

● Environmental product stewardship program

● Third-party licenses
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Warranty information
This section contains the following topics:

● Hewlett-Packard limited warranty statement

● Ink cartridge warranty information
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Hewlett-Packard limited warranty statement

Ink cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing
device. This warranty does not cover HP ink products that have been refilled, remanufactured,
refurbished, misused, or tampered with.
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During the warranty period the product is covered as long as the HP ink is not depleted and the end
of warranty date has not been reached. The end of warranty date, in YYYY-MM format, may be found
on the product as indicated:
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Printer specifications
This section contains the following topics:

● Physical specifications

● Product features and capacities

● Processor and memory specifications

● System requirements

● Network protocol specifications

● Embedded web server specifications

● Paper specifications

● Print resolution

● HP ePrint and HP website specifications

● Environmental specifications

● Electrical specifications

● Acoustic emission specifications

Physical specifications

Printer size (width x height x depth)

● 585 x 189 x 419 mm (23 x 7.4 x 16.5 inches)

Printer weight (does not include printing supplies)

● 8.1 kg (17.9 lb)

Product features and capacities

Feature Capacity

Connectivity ● USB 2.0-compliant high speed

● Wireless (802.11b/g/n 1) network

● Ethernet(802.3) network

1 This product supports the 802.11n 2.4 GHz frequency
band.

Print method Drop-on-demand thermal inkjet printing

Ink cartridges Four ink cartridges (one each for black, cyan, magenta, and
yellow)

NOTE: Not all ink cartridges are supported in all countries/
regions.

Printheads One printhead
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Feature Capacity

Supply yields Visit www.hp.com/go/learnaboutsupplies/ for more
information on estimated ink cartridge yields.

Printer languages HP PCL 3

Font support US fonts: CG Times, CG Times Italic, Universe, Universe
Italic, Courier, Courier Italic, Letter Gothic, Letter Gothic
Italic.

Duty cycle Up to 12,000 pages per month

Processor and memory specifications

Printer processor

● ARM R4

Printer memory

● 128 MB built-in RAM

System requirements
Software and system requirements are located in the Readme file.

NOTE: For the most current information about supported operating systems and system
requirements, visit www.hp.com/support.

Network protocol specifications
Software and system requirements are located in the Readme file.

Embedded web server specifications

Requirements

● A TCP/IP-based network (IPX/SPX-based networks are not supported)

● A web browser (either Microsoft Internet Explorer 7.0 or higher, Mozilla Firefox 3.0 or higher,
Safari 3.0 or higher, or Google Chrome 5.0 or higher)

● A network connection (cannot be used with a printer connected to a computer using a USB
cable)

● An Internet connection (required for some features)

NOTE: You can open the embedded web server without being connected to the Internet.
However, some features are not available.

NOTE: The embedded web server must be on the same side of a firewall as the printer.

104 Appendix A   Technical information ENWW

http://www.hp.com/go/learnaboutsupplies/
http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-001&h_page=hpcom&h_client=s-h-e008-1&h_product=5153793&h_lang=en&h_cc=us


Paper specifications
Use these tables to determine the correct paper to use with your printer, and determine what features
work with your paper.

● Understand specifications for supported paper

● Set minimum margins

● Guidelines for printing on both sides of a page

Understand specifications for supported paper
Use the tables to determine the correct paper to use with your printer, and to determine what features
work with your paper.

● Understand supported sizes

● Understand supported paper types and weights

Understand supported sizes

TIP: If you are using the duplexer, the minimum top and bottom margins must be at least 16 mm
(0.63 inches).

Paper size Input tray Duplexer

Standard paper sizes

10 x 15 cm*  

2L*  

U.S. Letter (216 x 279 mm; 8.5 x 11 inches)

8.5 x 13 inches (216 x 330 mm)

U.S. Legal (216 x 356 mm; 8.5 x 14 inches)

A4 (210 x 297 mm; 8.3 x 11.7 inches)*

U.S. Executive (184 x 267 mm; 7.25 x 10.5 inches)

U.S. Statement (140 x 216 mm; 5.5 x 8.5 inches)  

B5 (JIS) (182 x 257 mm; 7.17 x 10.12 inches)*

6 X 8 inches

A5 (148 x 210 mm; 5.8 x 8.3 inches)*  

Edge-to-Edge A4*  

Edge-to-Edge Letter*  

B sizes

11 x 14 inches*
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Paper size Input tray Duplexer

12 x 12 inches*  

B4 (JIS) (257 x 364 mm)

Tabloid (11 x 17 inches)*

Super B (13 x 19 inches)*  

A3 (297 x 420 mm; 11.69 x 16.54 inches)*

A3+ (330 x 483 mm; 12.99 x 18.98 inches)*  

Edge-to-Edge Tabloid (11 x 17 inches)*  

Edge-to-Edge A3*  

Envelopes

U.S. #10 Envelope (105 x 241 mm; 4.12 x 9.5 inches)  

Monarch Envelope (98 x 191 mm; 3.88 x 7.5 inches)  

No. 6 ¾ Envelope (92 x 165 mm; 3.63 x 6.5 inches)  

Card Envelope (111 x 152 mm; 4.4 x 6 inches)  

A2 Envelope (111 x 146 mm; 4.37 x 5.75 inches)  

DL Envelope (110 x 220 mm; 4.3 x 8.7 inches)  

C5 Envelope (162 x 229 mm; 6.4 x 9 inches)   

C6 Envelope (114 x 162 mm; 4.5 x 6.4 inches)  

Japanese Envelope Chou #3 (120 x 235 mm; 4.7 x 9.3
inches)

 

Japanese Envelope Chou #4 (90 x 205 mm; 3.5 x 8.1
inches)

 

Cards

Index card (76.2 x 127 mm; 3 x 5 inches)  

Index card (102 x 152 mm; 4 x 6 inches)  

Index card (127 x 203 mm; 5 x 8 inches)  

A6 card (105 x 148.5 mm; 4.13 x 5.83 inches)*  

A6 card (105 x 148.5 mm; 4.13 x 5.83 inches)*  

A4 index card (210 x 297 mm; 8.3 x 11.7 inches)  

Letter index card (8.5 x 11 inches)  

Hagaki (100 x 148 mm; 3.9 x 5.8 inches)**

Also supports Borderless printing.
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Paper size Input tray Duplexer

Ofuku Hagaki (200 x 148 mm; 7.8 x 5.8 inches)**  

Photo paper 

Photo paper (76.2 x 127 mm; 3 x 5 inches)  

Photo paper (102 x 152 mm; 4 x 6 inches)*   

Photo paper (5 x 7 inches)*  

Photo paper (8 x 10 inches)*  

Photo paper (8.5 x 11 inches)*  

Photo L (89 x 127 mm; 3.5 x 5 inches)*  

Photo 2L (127 x 178 mm)*  

Cabinet size (120x165mm)*  

13 x 18 cm*  

Brochures

B5 (JIS) (182 x 257 mm; 7.17 x 10.12 inches)*

11 x 14 inches*

Tabloid (11 x 17 inches)*

A3 (297 x 420 mm; 11.69 x 16.54 inches)*

Other paper 

NOTE: Defining custom-size paper sizes is only available in the HP printing software in
Mac OS X.

Custom-sized paper between 76.2 to 330 mm wide and 127
to 1118 mm long (3 to 13 inches wide and 5 to 44 inches
long)

 

*These sizes can be used for borderless printing.

** The printer is compatible with plain and inkjet hagaki from Japan Post only. It is not compatible with
photo hagaki from Japan Post.
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Understand supported paper types and weights

Tray Type Weight Capacity

Input tray Paper 60 to 105 g/m2

(16 to 28 lb bond)

Up to 250 sheets of 20lb
HP Multipurpose Paper

(25 mm or 1 inch stacked)

Photo paper 280 gsm

(75 lb bond)

Up to 60 sheets of 280 gsm
HP Premium Plus Photo Paper

(17 mm or 0.67 inch stacked)

Envelopes 75 to 90 g/m2

(20 to 24 lb bond envelope)

Up to 30 sheets

(17 mm or 0.67 inch stacked)

Cards Up to 200 g/m2

(110 lb index)

Up to 80 cards

Brochures 180 gsm Up to 65 sheets of 180 gsm HP
Brochure and Flyer Paper
Matte

Duplexer Plain and brochure 60 to 180 g/m2

(16 to 48 lb bond)

Not applicable

Output-tray All supported paper  Up to 75 sheets of plain paper
(text printing)

Set minimum margins
The document margins must match (or exceed) these margin settings in portrait orientation.
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Paper (1) Left margin (2) Right margin (3) Top margin (4) Bottom margin

U.S. Letter

U.S. Legal

A4

U.S. Executive

U.S. Statement

8.5 x 13 inch

B5

A5

Cards

Custom-sized paper

Photo paper

3.3 mm (0.13 inch) 3.3 mm (0.13 inch) 3.3 mm (0.13 inch) 3.3 mm (0.13
inch) Windows
and 12mm (0.47
inch) Mac and
Linux

11 x 14 inches

12 x 12 Inches

B4 (JIS)

Tabloid

Super B

A3

A3+

Edge-to-Edge Tabloid

Edge-to-Edge A3

5 mm (0.197
inch)1

5 mm (0.197
inch)1

5 mm (0.197 inch)2 5 mm (0.197
inch)2

Envelopes 3.3 mm (0.13 inch) 3.3 mm (0.13 inch) 16.5 mm (0.65
inch)

16.5 mm (0.65
inch)

1 The margins for plain and brochure paper are 13 mm (0.51 inch) for simplex and duplex.

2 The margins for plain paper are 16 mm (0.63 inch) for simplex and 22 mm (0.87 inch) for duplex.
For brochure paper, the margins are 16 mm (0.63 inch) for simplex and duplex.

Guidelines for printing on both sides of a page
● Always use paper that conforms to the printer specifications. For more information, see Paper

specifications on page 105.

● Specify two-sided printing options in your application or in the printer driver.

● Do not print on both sides of envelopes, photo paper, glossy paper, or paper lighter than 16 lb
bond (60 g/m2) or heavier than 28 lb bond (105 g/m2). Jams might occur with these paper types.

● Several kinds of papers require a specific orientation when you print on both sides of a page.
These include letterhead, preprinted paper, and paper with watermarks and prepunched holes.
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When you print from a computer running Windows, the printer prints the first side of the paper
first. Load the paper with the print side facing down.

● For auto-duplexing, when printing finishes on one side of the paper, the printer holds the paper
and pauses while the ink dries. Once the ink dries, the paper is pulled back into the printer and
the second side is printed. When printing is complete, the paper is dropped onto the output tray.
Do not grab it before printing is complete.

● You can print on both sides of supported custom-size paper by turning the paper over and
feeding it into the printer again. For more information, see Paper specifications on page 105.

Print resolution
Table A-1  Print resolution

Draft mode ● Color Input/Black Render: 300x300dpi

● Output (Black/Color): Automatic

Normal mode ● Color Input/Black Render: 600x600dpi

● Output (Black/Color): Automatic

Best mode ● Color Input/Black Render: 600x600dpi

● Output (Black/Color): Automatic

Max DPI mode ● Color Input/Black Render: 1200x1200dpi

● Output: Automatic (Black), 4800x1200 optimized dpi (Color)

HP ePrint and HP website specifications
This section contains the following topics:

● HP ePrint specifications

● HP website specifications

HP ePrint specifications
● An Internet connection using either an Ethernet or wireless connection.

● Maximum size of email and attachments: 5 MB

● Maximum number of attachments: 10

NOTE: The HP ePrint server does not accept email print jobs if there are multiple email
addresses included in the "To" or "Cc" fields. Only enter the email address of your HP printer in
the "To" field. Do not enter any additional email addresses in the other fields.

● Supported file types:

◦ PDF

◦ HTML

◦ Standard text file formats
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◦ Microsoft Word, PowerPoint

◦ Image files, such as PNG, JPEG, TIFF, GIF, BMP

NOTE: You might be able to use other types of files with HP ePrint. However, HP cannot
guarantee that they correct functionality with the printer because they have not been fully tested.

HP website specifications
● A web browser (either Microsoft Internet Explorer 6.0 or higher, Mozilla Firefox 2.0 or higher,

Safari 3.2.3 or higher, or Google Chrome 3.0) with the Adobe Flash plug-in (version 10 or
higher).

● An Internet connection

Environmental specifications

Operating environment

● Operating temperature: 5° to 40° C (41° to 104° F)

Recommended operating conditions: 15° to 32° C (59° to 90° F)

Recommended relative humidity: 25 to 75% noncondensing

Storage environment

● Storage temperature: -40° to 60° C (-40° to 140° F)

Storage relative humidity: Up to 90% noncondensing at a temperature of 60° C (140° F)

Electrical specifications

Power supply

● Universal power adapter (external)

Power requirements

● Input voltage: 100 to 240 VAC (± 10%), 50/60 Hz (± 3 Hz) (Worldwide); 200 to 240 VAC, 50/60
Hz (China and India only)

Output voltage: +32Vdc / +12Vdc (1094mA / 250mA)

Power consumption

● 30 watts printing (Fast Draft Mode)

Acoustic emission specifications
Print in Draft mode, noise levels per ISO 7779

● Sound pressure (bystander position)

◦ LpAm 54 (dBA) (mono Draft print)

● Sound power
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◦ LwAd 6.7 (BA)
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Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory model number

● FCC statement

● Notice to users in Korea

● VCCI (Class B) compliance statement for users in Japan

● Notice to users in Japan about the power cord

● Noise emission statement for Germany

● GS Declaration (Germany)

● European Union Regulatory Notice

● Regulatory information for wireless products

Regulatory model number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SNPRC-1103-02. This regulatory number should not be
confused with the marketing name (HP Officejet 7110 Wide Format ePrinter) or product number
(CR768A).
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FCC statement

Notice to users in Korea
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VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

Noise emission statement for Germany

GS Declaration (Germany)

European Union Regulatory Notice
Products bearing the CE marking comply with the following EU Directives:

● Low Voltage Directive 2006/95/EC

● EMC Directive 2004/108/EC

● Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid if powered with the correct CE-marked AC adapter provided by
HP.

If this product has wired and/or wireless telecommunications functionality, it also complies with the
essential requirements of the following EU Directive:
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● R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European standards
(European Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or
product family and available (in English only) either within the product documentation or at the
following web site: www.hp.com/go/certificates (type the product number in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications products and for EU
harmonized telecommunications products, such
as Bluetooth® within power class below 10mW.

For EU non-harmonized telecommunications
products (If applicable, a 4-digit notified body
number is inserted between CE and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France,
Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg,
Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue
telephone networks.

Products with wireless LAN devices

● Some countries may have specific obligations or special requirements about the operation of
Wireless LAN networks such as indoor use only or restrictions of the channels available. Please
make sure that the country settings of the wireless network are correct.

France

● For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may
be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For
outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used.
For the latest requirements, see www.arcep.fr.

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY

Regulatory information for wireless products
This section contains the following regulatory information pertaining to wireless products:

● Exposure to radio frequency radiation

● Notice to users in Brazil

● Notice to users in Canada

● Notice to users in Taiwan
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● Notice to users in Mexico

● Notice to users in Japan

Exposure to radio frequency radiation

Notice to users in Brazil
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Notice to users in Canada

Notice to users in Taiwan
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Notice to users in Mexico

Notice to users in Japan
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Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sustainable manner:

● Design for recycling has been incorporated into this product.

● The number of materials has been kept to a minimum while ensuring proper functionality and
reliability.

● Dissimilar materials have been designed to separate easily.

● Fasteners and other connections are easy to locate, access, and remove using common tools.

● High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit www.hp.com/ecosolutions

This section contains the following topics:

● Paper use

● Plastics

● Material safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Disposal of waste equipment by users in private households in the European Union

● Power consumption

● Chemical Substances

● Battery information

● RoHS notices (China only)

● RoHS notices (Ukraine only)

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:

www.hp.com/go/msds
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Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronic recycling centers throughout the world. HP conserves
resources by reselling some of its most popular products. For more information regarding recycling of
HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free
of charge. For more information, go to the following Web site:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/
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Disposal of waste equipment by users in private households in the European
Union

Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified
to the U.S. Environmental Protection Agency's ENERGY STAR specifications for imaging equipment.
The following mark appears on ENERGY STAR qualified imaging products:
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Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Chemical Substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Battery information
This section contains the following topics:

● Battery disposal in Taiwan

● Attention California users

● Battery disposal in the Netherlands

Battery disposal in Taiwan

Attention California users

Battery disposal in the Netherlands

ENWW Environmental product stewardship program 123

http://www.hp.com/go/energystar
http://www.hp.com/go/reach


RoHS notices (China only)
Figure A-1  Toxic and hazardous substance table

RoHS notices (Ukraine only)
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Third-party licenses

LICENSE.aes-pubdom--crypto

---------------------

/* rijndael-alg-fst.c

 *

 * @version 3.0 (December 2000)

 *

 * Optimised ANSI C code for the Rijndael cipher (now AES)

 *

 * @author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>

 * @author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>

 * @author Paulo Barreto <paulo.barreto@terra.com.br>

 *

 * This code is hereby placed in the public domain.

 *

 * THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS

 * OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

 * WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

 * ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE

 * LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

 * CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF

 * SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

 * BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

 * WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE

 * OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,

 * EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

 */

LICENSE.expat-mit--expat

ENWW Third-party licenses 125



---------------------

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining

a copy of this software and associated documentation files (the

"Software"), to deal in the Software without restriction, including

without limitation the rights to use, copy, modify, merge, publish,

distribute, sublicense, and/or sell copies of the Software, and to

permit persons to whom the Software is furnished to do so, subject to

the following conditions:

The above copyright notice and this permission notice shall be included

in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.

IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY

CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,

TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE

SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LICENSE.hmac-sha2-bsd--nos_crypto

---------------------

/* HMAC-SHA-224/256/384/512 implementation

* Last update: 06/15/2005

* Issue date: 06/15/2005

*

* Copyright (C) 2005 Olivier Gay <olivier.gay@a3.epfl.ch>

* All rights reserved.

* 
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* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. Neither the name of the project nor the names of its contributors

* may be used to endorse or promote products derived from this software

* without specific prior written permission.

*

* THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS

* BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF

* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

* BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

* WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR

* OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF

* ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

*/

LICENSE.open_ssl--open_ssl

---------------------

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written
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by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as

the following conditions are aheared to. The following conditions

apply to all code found in this distribution, be it the RC4, RSA,

lhash, DES, etc., code; not just the SSL code. The SSL documentation

included with this distribution is covered by the same copyright terms

except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in

the code are not to be removed.

If this package is used in a product, Eric Young should be given attribution

as the author of the parts of the library used.

This can be in the form of a textual message at program startup or

in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the copyright

 notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright

 notice, this list of conditions and the following disclaimer in the

 documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software

 must display the following acknowledgement:

 "This product includes cryptographic software written by

 Eric Young (eay@cryptsoft.com)"

 The word 'cryptographic' can be left out if the rouines from the library

 being used are not cryptographic related :-).
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4. If you include any Windows specific code (or a derivative thereof) from

 the apps directory (application code) you must include an acknowledgement:

 "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND

ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE

LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE

POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or

derivative of this code cannot be changed. i.e. this code cannot simply be

copied and put under another distribution licence

[including the GNU Public Licence.]

====================================================================

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright

 notice, this list of conditions and the following disclaimer. 
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2. Redistributions in binary form must reproduce the above copyright

 notice, this list of conditions and the following disclaimer in

 the documentation and/or other materials provided with the

 distribution.

3. All advertising materials mentioning features or use of this

 software must display the following acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to

 endorse or promote products derived from this software without

 prior written permission. For written permission, please contact

 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"

 nor may "OpenSSL" appear in their names without prior written

 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following

 acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY

EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
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LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,

STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

OF THE POSSIBILITY OF SUCH DAMAGE.

====================================================================

This product includes cryptographic software written by Eric Young

(eay@cryptsoft.com). This product includes software written by Tim

Hudson (tjh@cryptsoft.com).

====================================================================

Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the above copyright

 notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright

 notice, this list of conditions and the following disclaimer in

 the documentation and/or other materials provided with the

 distribution.

3. All advertising materials mentioning features or use of this

 software must display the following acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
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4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to

 endorse or promote products derived from this software without

 prior written permission. For written permission, please contact

 openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"

 nor may "OpenSSL" appear in their names without prior written

 permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following

 acknowledgment:

 "This product includes software developed by the OpenSSL Project

 for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY

EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,

STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

OF THE POSSIBILITY OF SUCH DAMAGE.

====================================================================

This product includes cryptographic software written by Eric Young

(eay@cryptsoft.com). This product includes software written by Tim
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Hudson (tjh@cryptsoft.com).

====================================================================

Copyright 2002 Sun Microsystems, Inc. ALL RIGHTS RESERVED.

ECC cipher suite support in OpenSSL originally developed by 

SUN MICROSYSTEMS, INC., and contributed to the OpenSSL project.

LICENSE.sha2-bsd--nos_crypto

---------------------

/* FIPS 180-2 SHA-224/256/384/512 implementation

* Last update: 02/02/2007

* Issue date: 04/30/2005

 *

* Copyright (C) 2005, 2007 Olivier Gay <olivier.gay@a3.epfl.ch>

 * All rights reserved.

 *

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

 * are met:

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. Neither the name of the project nor the names of its contributors

* may be used to endorse or promote products derived from this software

* without specific prior written permission.

 *

* THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND
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* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE

* LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF

* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS

* INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN

* CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF

 * THE POSSIBILITY OF SUCH DAMAGE.

 */

LICENSE.zlib--zlib

---------------------

zlib.h -- interface of the 'zlib' general purpose compression library

version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied

warranty. In no event will the authors be held liable for any damages

arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,

including commercial applications, and to alter it and redistribute it

freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not

 claim that you wrote the original software. If you use this software

 in a product, an acknowledgment in the product documentation would be

 appreciated but is not required.
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2. Altered source versions must be plainly marked as such, and must not be

 misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler

jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for

Comments) 1950 to 1952 in the files http://www.ietf.org/rfc/rfc1950.txt

(zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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B HP supplies and accessories

This section provides information on HP supplies and accessories for the printer. The information is
subject to changes, visit the HP website (www.hpshopping.com) for the latest updates. You may also
make purchases through the website.

NOTE: Not all cartridges are available in all countries/regions.

This section contains the following topics:

● Order printing supplies online

● Supplies
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Order printing supplies online
To order supplies online or create a printable shopping list, open the HP software that came with your
printer and click Shopping. Select Shop for Supplies Online. The HP software uploads, with your
permission, printer information, including model number, serial number, and estimated ink levels. The
HP supplies that work in your printer are pre-selected. You can change quantities, add or remove
items, and then print the list or purchase online at the HP Store or other online retailers (options differ
by country/region). Cartridge information and links to online shopping also appear on ink alert
messages.

You can also order online by visiting www.hp.com/buy/supplies. If prompted, select your country/
region, follow the prompts to select your printer, and then the supplies you need.

NOTE: Ordering cartridges online is not supported in all countries/regions. However, many
countries have information on ordering by telephone, locating a local store and printing a shopping
list. In addition, you can select the 'How to Buy' option at the top of the www.hp.com/buy/supplies
page to obtain information about purchasing HP products in your country.
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Supplies
● Ink cartridges

● HP paper

Ink cartridges
Ordering cartridges online is not supported in all countries/regions. However, many countries have
information on ordering by telephone, locating a local store and printing a shopping list. In addition,
you can select the How to Buy option at the top of the www.hp.com/buy/supplies page to obtain
information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the ink cartridge you are
replacing. You can find the cartridge number in the following places:

● In the embedded web server, click the Tools tab, and then, under Product Information click Ink
Gauge. For more information, see Embedded web server on page 155.

● On the label of the ink cartridge you are replacing.

● On the printer status page (see Understand the Printer Status Report on page 81).

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you
receive a low-ink warning message, consider having a replacement cartridge available to avoid
possible printing delays. You do not need to replace cartridges until prompted to do so.

HP paper
To order paper such as HP Premium Paper, go to www.hp.com.

HP recommends plain papers with the ColorLok logo for printing everyday
documents. All papers with the ColorLok logo are independently tested to meet high
standards of reliability and print quality, and produce documents with crisp, vivid
color, bolder blacks, and that dry faster than ordinary plain papers. Look for papers
with the ColorLok logo in a variety of weights and sizes from major paper
manufacturers.
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C Network setup

You can manage network settings for the printer through the printer control panel as described in the
next section. Additional advanced settings are available in the embedded web server, a configuration
and status tool you access from your web browser using an existing network connection to the
printer. For more information, see Embedded web server on page 155.

This section contains the following topics:

● Change basic network settings

● Change advanced network settings

● Set up the printer for wireless communication

● HP wireless direct printing
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Change basic network settings
The control panel options enable you to set up and manage a wireless connection and to perform
a variety of network management tasks. This includes viewing the network settings, restoring the
network defaults, turning the wireless radio on and off, and changing the network settings.

This section contains the following topics:

● View and print network settings

● Turn the wireless radio on and off

View and print network settings
You can display a summary of the network settings on the HP software that came with the printer.
You can print a more detailed network configuration page, which lists all of the important network
settings such as the IP address, link speed, DNS, and mDNS. For more information, see Understand
the network configuration page on page 83.

Turn the wireless radio on and off
The wireless radio is on by default, as indicated by the blue light on the front of the printer. To stay
connected to a wireless network, the radio must stay on. However, if your printer is connected to
an Ethernet network or you have a USB connection, the radio is not used. In this case you might want
to turn the radio off. To turn the wireless radio off, press and hold the  (Wireless) button until the
light goes off.
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Change advanced network settings
CAUTION: Network settings are provided for your convenience. However, you should not change
some of these settings (such as the link speed, IP settings, default gateway, and firewall settings).

This section contains the following topics:

● Set link speed

● View IP settings

● Change IP settings

● Reset network settings

Set link speed
You can change the speed at which data is transmitted over the network. The default is Automatic.

1. Open the embedded web server (EWS). For more information, see Embedded web server
on page 155.

2. Click the Network tab, and then click Advanced in the Wired (802.3) section.

3. In the Link Settings section, click Manual.

4. Click to select the link speed that matches your network hardware:

● 2. 10-Full

● 3. 10-Half

● 4. 100-Full

● 5. 100-Half

View IP settings
To view the IP address of the printer:

● Print the network configuration page. For more information, see Understand the network
configuration page on page 83.

● Or, open the HP software (Windows), click the Network Settings tab, click the Wired or Wireless
tab (depending on the current connection), and then click IP Settings.

Change IP settings
The default IP setting for the IP settings is Automatic, which sets the IP settings automatically.
However, you might want to manually change settings such as the IP address, subnet mask, or the
default gateway.

CAUTION: Be careful when manually assigning an IP address. If you enter an invalid IP address
during the installation, your network components cannot connect with the printer.
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1. Open the embedded web server. For more information, see Embedded web server
on page 155.

2. Click the Network tab, and then click IPv4 Configuration in the Wired (802.3) section.

3. In the IP Address Configuration section, click Manual.

4. A message appears warning that changing the IP address removes the printer from the network.
Click OK to continue.

5. Change the IP settings:

● Manual IP Address

● Manual Subnet Mask

● Manual Default Gateway

6. Click Apply.

Reset network settings
To reset the administrator password and network settings, press and hold the  (Wireless) button
and the  (Cancel) button for three seconds.

NOTE: Print the network configuration page and verify that the network settings have been reset.
For more information, see Understand the network configuration page on page 83.

By default, the network name (SSID) is “HP-Print-**-Officejet 7110”, where “**” is a random number
generated by the printer.
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Set up the printer for wireless communication
You can set up the printer for wireless communication.

This section contains the following topics:

● Before you begin

● Set up the printer on your wireless network

● Change the connection type

● Test the wireless connection

● Guidelines for ensuring wireless network security

● Guidelines for reducing interference on a wireless network

NOTE: If you encounter problems connecting the printer, see Solve wireless problems on page 71.

TIP: For more information about setting up and using the printer wirelessly, visit the HP Wireless
Printing Center (www.hp.com/go/wirelessprinting).

Before you begin
Before you begin setting up the wireless connection, check the following:

● The printer is not connected to the network using a network cable.

● The wireless network is set up and functioning correctly.

● The printer and the computers that use the printer are on the same network (subnet).

While connecting the printer, you might be prompted to enter the wireless network name (SSID) and
a wireless password.

● The wireless network name is the name of your wireless network.

● The wireless password prevents other people from connecting to your wireless network without
your permission. Depending on the level of security required, your wireless network might use
either a WPA key or WEP passphrase.

If you have not changed the network name or the security passkey since setting up your wireless
network, you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security passkey or cannot remember this information, see
the documentation available with your computer or with the wireless router. If you still cannot find this
information, contact your network administrator or the person who set up the wireless network.

TIP: If you are using a computer running Windows, use the HP Print and Scan Doctor to help
diagnose and get assistance in installing and using HP printers on your home network. To use this
tool, visit the HP Wireless Printing Center (www.hp.com/go/wirelessprinting), and then click Print and
Scan Doctor in the Quick Links section.

Set up the printer on your wireless network
To set up the printer on your wireless network, use one of the following methods:
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● Set up the printer using the HP printer software

● Set up the printer using WiFi Protected Setup (WPS)

● Set up the printer using the embedded web server (EWS)

NOTE: Make sure you have installed the HP software that came with the printer and the printer
network drives. For more information about how to installed the drives, see After resolving the
problems on page 78.

NOTE: If you have already been using the printer with a different type of connection, such as a USB
connection, follow the instructions in Change the connection type on page 145 to set up the printer
on your wireless network.

Set up the printer using the HP printer software
In addition to enabling key printer features, you can use the HP printer software that came with your
printer to set up wireless communication.

If you have already been using the printer with a different type of connection, such as a USB
connection, follow the instructions in Change the connection type on page 145 to set up the printer
on your wireless network.

Set up the printer using WiFi Protected Setup (WPS)
Wi-Fi Protected Setup (WPS) allows you to quickly set up the printer on your wireless network,
without having to enter the wireless network name (SSID), wireless password (WPA passphrase,
WEP key), or other wireless settings.

NOTE: Only set up wireless using WPS if your wireless network uses WPA data encryption. If your
wireless network uses WEP or is not using any encryption at all, use one of the other methods
provided in this section to set up the printer on your wireless network.

NOTE: To use WPS, make sure your wireless router or wireless access point supports WPS.
Routers that support WPS often have a  (WPS) button or a button labeled “WPS”.

You can use one of the following methods to set up the printer using WPS:

● Push Button Method: Use the  (WPS) or WPS button, if available, on your router.

● PIN Method: Enter the PIN generated by the printer in the router's configuration software.

To connect the printer using the Push Button Method

1. On the printer control panel, press and hold the  (Wireless) button for 3 seconds. The wireless
light starts blinking.

2. On the wireless router or wireless access point, press and hold the WPS button for 3 seconds.

Wait for about 2 minutes. If the printer connects successfully, the wireless light stops blinking but
remains lit.
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To connect the printer using the PIN Method

1. Print the network configuration page and locate the pin for WPS. For more information, see
Understand the network configuration page on page 83.

A WPS PIN is printed at the top of the page.

2. On the printer control panel, press and hold the  (Wireless) button for 3 seconds. The Wireless
light starts blinking.

3. Open the configuration utility or software for the wireless router or wireless access point, and
then enter the WPS PIN.

NOTE: For more information about using the configuration utility, see the documentation
provided with the router or wireless access point.

Wait for about 2 minutes. If the printer connects successfully, the wireless light stops blinking but
remains lit.

Set up the printer using the embedded web server (EWS)
If the printer is connected to a network, you can use the printer's embedded web server (EWS) to set
up wireless communication.

1. Open the EWS. For more information, see Embedded web server on page 155.

2. On the Home tab, click Wireless Setup Wizard in the Setup box.

3. Follow the on-screen instructions.

TIP: You can also set up wireless communication by entering or changing individual wireless
settings. To change these settings, on the Network tab, click Advanced in the Wireless (802.11)
section on the left, change the wireless settings, and then click Apply.

Change the connection type
After you have installed the HP software and connected the printer to your computer or to a network,
you can use the HP software to change the connection type (for example, from a USB connection to
a wireless connection).

NOTE: If you are changing to a wireless connection, make sure that an Ethernet cable has not been
connected to the printer. Connecting an Ethernet cable turns off the printer's wireless capabilities.
Also, you might be prompted to temporarily connect a USB cable during the setup process.

To change the connection type, do one of the following:

● To change from an Ethernet connection to a wireless connection

● To change from a USB connection to a wireless connection

● To change from a wireless connection to a USB or Ethernet connection
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To change from an Ethernet connection to a wireless connection

Windows

1. On the computer desktop, click Start, select Programs or All Programs, click HP, select your
printer name, and then click Printer Setup & Software.

- Or -

On the Start screen, click Printer Setup & Software.

2. Click Connect a new printer, and then select the type of connection you want to use.

3. Follow the display instructions to complete the setup.

Mac OS X

1. Open HP Utility. For more information, see HP Utility (Mac OS X) on page 154.

2. Click the Applications icon on the HP Utility toolbar.

3. Double-click HP Setup Assistant, and then follow the on-screen instructions.

To change from a USB connection to a wireless connection
Follow the instructions for your operating system.

Windows

1. On the computer desktop, click Start, select Programs or All Programs, click HP, select your
printer name, and then click Printer Setup & Software.

- Or -

On the Start screen, click Printer Setup & Software.

2. Click Convert a USB connected printer to wireless.

3. Follow the display instructions to complete the setup.

Mac OS X

1. Open HP Utility. For more information, see HP Utility (Mac OS X) on page 154.

2. Click the Applications icon on the HP Utility toolbar.

3. Double-click HP Setup Assistant, and then follow the on-screen instructions.

To change from a wireless connection to a USB or Ethernet connection
To change from a wireless connection to a USB or Ethernet connection, connect the USB or Ethernet
cable to the printer.

NOTE: If you are using a computer with Mac OS X, add the printer to the print queue. Click System
Preferences in the Dock, click Print & Fax or Print & Scan in the Hardware section, click +, and then
select the printer.
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Test the wireless connection
Print the wireless test page for information about the printer's wireless connection. The wireless test
page provides information about the printer's status, hardware (MAC) address, and IP address. If the
printer is connected to a network, the test page displays details about the network settings.

To print the wireless test page, press the  (Network Information) button when the network is
enabled.

Guidelines for ensuring wireless network security
The following information can help you keep your wireless network and wireless printer secure from
unauthorized use.

For more information, visit www.hp.com/go/wirelessprinting.

This section contains the following topics:

● Overview of security settings

● Add hardware addresses to a wireless router (MAC filtering)

● Other wireless security guidelines

Overview of security settings
To help improve the security of the wireless network and prevent unauthorized access, the printer
supports many common types of network authentication, including WEP, WPA, and WPA2.

● WEP: Provides security by encrypting data sent over radio waves from one wireless device to
another wireless device. Devices on a WEP-enabled network use WEP keys to encode data. If
your network uses WEP, you must know the WEP key(s) it uses.

● WPA: Increases the level of over-the-air data protection and access control on existing and
future wireless networks. It addresses all known weaknesses of WEP, the original native security
mechanism in the 802.11 standard. WPA uses the Temporal Key Integrity Protocol (TKIP) for
encryption and employs 802.1X authentication with one of the standard Extensible
Authentication Protocol (EAP) types available today.

● WPA2: Provides enterprise and consumer wireless users with a high level of assurance that only
authorized users can access their wireless networks. WPA2 provides the Advanced Encryption
Standard (AES). AES is defined in counter cipher-block chaining mode (CCM) and supports the
Independent Basic Service Set (IBSS) to enable security between client workstations operating
connected wirelessly without a wireless router (such as a Linksys wireless router or Apple
AirPort Base Station).

Add hardware addresses to a wireless router (MAC filtering)
MAC filtering is a security feature in which a wireless router or wireless access point is configured
with a list of hardware addresses (also called "MAC addresses") of devices that are allowed to gain
access to the network through the router.

If the router filters hardware addresses, then the printer's hardware address must be added to the
router's list of accepted hardware addresses. If the router does not have the hardware address of a
printer attempting to access the network, the router denies the printer access to the network.
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CAUTION: This method is not recommended, however, because your MAC addresses can easily
be read and falsified by unwanted users outside your network.

To add hard addresses to a wireless router or wireless access point

1. Print the network configuration page, and then locate the printer's hardware address. For more
information, see Understand the network configuration page on page 83.

NOTE: The printer maintains separate hardware addresses for the Ethernet connection and for
wireless connection. Both hardware addresses are listed on the printer's network configuration
page.

2. Open the configuration utility for the wireless router or wireless access point, and add the
printer's hardware address to the list of accepted hardware addresses.

NOTE: For more information about using the configuration utility, see the documentation provided
with the router or wireless access point.

Other wireless security guidelines
To keep the wireless network secure, follow these guidelines:

● Use a wireless password with at least 20 random characters. You can use up to 64 characters in
a wireless password.

● Avoid any common words or phrases, easy sequences of characters (such as all 1s), and
personally-identifiable information for wireless passwords. Always use random strings composed
of uppercase and lowercase letters, numbers, and if allowed, special characters such as
punctuation.

● Change the default wireless password provided by the manufacturer for administrator access to
the access point or wireless router. Some routers let you change the administrator name as well.

● Turn off administrative access over wireless if possible. If you do this, you need to connect to the
router with an Ethernet connection when you want to make configuration changes.

● Turn off remote administrative access over the Internet on your router, if possible. You can use
Remote Desktop to make an encrypted connection to a computer running behind your router
and make configuration changes from the local computer you are accessing over the Internet.

● To avoid accidentally connecting to another party's wireless network, turn off the setting to
automatically connect to non-preferred networks. This is disabled by default in Windows XP.

Guidelines for reducing interference on a wireless network
The following tips will help reduce the chances for interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones, as these objects can
disrupt radio signals.

● Keep the wireless devices away from large masonry structures and other building structures as
these objects can absorb radio waves and lower signal strength.

● Position the access point or wireless router in a central location in line of sight with the wireless
devices on the network.

● Keep all wireless devices on the network within range of one another.
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HP wireless direct printing
With HP wireless direct printing, you can print wirelessly from a computer, smart phone, tablet, or
other wireless-capable device—without connecting to an existing wireless network.

When using HP wireless direct printing, note the following guidelines:

● Make sure your computer or mobile device has the necessary software:

◦ If you are using a computer, make sure you have installed the HP printer software provided
with the printer.

● If you are using a mobile device, make sure you have installed a compatible printing app. For
more information about mobile printing, visit www.hp.com/global/us/en/eprint/
mobile_printing_apps.html.

● Make sure HP wireless direct printing is turned on in the printer and, if necessary, security is
enabled. For more information, see Turn on HP wireless direct printing on page 149.

● Up to five computers and mobile devices can use the same HP wireless direct printing
connection.

● HP wireless direct printing can be used while the printer is also connected to a computer using
USB cable or to a network (using a wireless or Ethernet connection).

● HP wireless direct printing cannot be used to connect a computer, mobile device, or printer to
the Internet.

Click here to go online for more information.

For more information about wireless printing, see Set up the printer using the embedded web server
(EWS) on page 145.

NOTE: At this time, these websites might not be available in all languages.

This section contains the following topics:

● Turn on HP wireless direct printing

● Print from a wireless-capable mobile device

● Print from a wireless-capable computer

Turn on HP wireless direct printing
1. Open the EWS. For more information, see Embedded web server on page 155.

2. Click the Network tab.

3. In the Wireless Direct Printing section, click Status.
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4. Select On (with security) or On (without security) from the Wireless Direct Printing Status.

TIP: If you would like to use HP wireless direct printing with greater security and if the
computer or mobile device supports WPA2 encryption, select the option that will enable security.
With security enabled, only users with the password can connect wirelessly to the printer.
Without enabling security, anyone with a wireless device within the wireless range of the printer
can connect to the printer.

5. Click Apply.

Print from a wireless-capable mobile device
Make sure you have installed a compatible printing app on your mobile device. For more information,
visit www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

1. Make sure you have turned on HP wireless direct printing on the printer. For more information,
see Turn on HP wireless direct printing on page 149.

2. Turn on the wireless connection in your mobile device. For more information, see the
documentation provided with the mobile device.

3. From the mobile device, search for and connect to the HP wireless direct printing name, such as
HP-Print-**-Officejet 7110 series (where ** are the unique characters to identify your printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. From your mobile device’s print app, confirm your HP printer is the default printer, and then print
your document.

Print from a wireless-capable computer
Follow the instructions for your operating system.

● Print from a wireless-capable computer (Windows)

● Print from a wireless-capable computer (Mac OS X)

Print from a wireless-capable computer (Windows)
1. Make sure you have turned on HP wireless direct printing on the printer. For more information,

see Turn on HP wireless direct printing on page 149.

2. Turn on the wireless connection in your computer. For more information, see the documentation
provided with the computer.

3. From the computer, click the wireless icon on your task tray, select the HP wireless direct
printing name, such as HP-Print-**-Officejet 7110 series (where ** are the unique characters to
identify your printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. If the printer has been installed and connected to your computer with a USB cable, enable HP
wireless direct printing in the HP printer software. Proceed to step 5 if the printer has been
installed and connected to the computer over a network (Ethernet or wireless).
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a. From the computer desktop, click Start, select Programs or All Programs, click HP, click the
folder for the printer, and then select Printer Setup & Software.

- Or -

On the Start screen, right-click an empty area on the screen, click All Apps on the app bar,
and then click the icon with the printer’s name.

b. Select Connect New Printer.

c. When the Connection Options software screen appears, select Wireless.

Select the printer from the list of detected printers, such as HP-Print-**-Officejet 7110 series
(where ** are the unique characters to identify your printer).

d. Follow the on-screen instructions.

5. Print your document.

Print from a wireless-capable computer (Mac OS X)
1. Make sure you have turned on HP wireless direct printing on the printer. For more information,

see Turn on HP wireless direct printing on page 149.

2. Turn on AirPort. For more information, see the documentation provided by Apple.

3. Click the AirPort icon and select the HP wireless direct printing name, such as HP-Print-**-
Officejet 7110 series (where ** are the unique characters to identify your printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Add the printer.

a. In System Preferences, select Print & Fax or Print & Scan, depending on your operating
system.

b. Click + below the list of printers at the left.

c. Select the printer from the list of detected printers (the word “Bonjour” is listed the right
column beside the printer name), and click Add.

5. Print your document.
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D Printer management tools

This section contains the following topics:

● Toolbox (Windows)

● HP Utility (Mac OS X)

● Embedded web server
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Toolbox (Windows)
The Toolbox provides maintenance information about the printer.

NOTE: The Toolbox can be installed from the HP Software CD if the computer meets the system
requirements.

● Open the Toolbox

Open the Toolbox
1. Open the HP printer software by doing one of the following:

● From the computer desktop, click Start, select Programs or All Programs, click HP, click the
folder for the printer, and then select the icon with the printer's name.

● On the Start screen, right-click an empty area on the screen, click All Apps on the app bar,
and then click the icon with the printer's name.

2. In the window that appears, select Print, Scan & Fax or Print & Scan, and then select Maintain
Your Printer under Print.
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HP Utility (Mac OS X)
HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and find
website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low-ink warning message, consider having a replacement cartridge available to avoid possible
printing delays. You do not need to replace cartridges until prompted to do so.

To open HP Utility
Double-click the HP Utility icon. This icon is located in the Hewlett-Packard folder in the Applications
folder at the top level of the hard disk.
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Embedded web server
When the printer is connected to a network, you can use the printer's home page (embedded web
server or EWS) to view status information, change settings, and manage it from your computer.

NOTE: For a list of system requirements for the embedded web server, see Embedded web server
specifications on page 104.

To view or change some settings, you might need a password.

You can open and use the embedded web server without being connected to the Internet. However,
some features are not available.

This section contains the following topics:

● About cookies

● To open the embedded web server

About cookies
The embedded web server (EWS) places very small text files (cookies) on your hard drive when you
are browsing. These files let the EWS recognize your computer the next time you visit. For example,
if you have configured the EWS language, a cookie helps remember which language you have
selected so that the next time you access the EWS, the pages are displayed in that language.
Though some cookies are cleared at the end of each session (such as the cookie that stores the
selected language), others (such as the cookie that stores customer-specific preferences) are stored
on the computer until you clear them manually.

NOTE: The cookies that the EWS stores on your computer are only used for saving settings on your
computer or for sharing information between the printer and the computer. These cookies are not
sent to any HP websites.

You can configure your browser to accept all cookies, or you can configure it to alert you every time
a cookie is offered, which allows you to decide which cookies to accept or refuse. You can also use
your browser to remove unwanted cookies.

NOTE: Depending on your printer, if you disable cookies, you also disable one or more of the
following features:

● Starting where you left the application (especially useful when using setup wizards)

● Remembering the EWS browser language setting

● Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete
cookies, see the documentation available with your web browser.

To open the embedded web server
NOTE: The printer must be on a network and must have an IP address. The IP address and
hostname for the printer are listed on the status report. For more information, see Understand the
network configuration page on page 83.

● In a supported web browser on your computer, type the IP address or hostname assigned to the
printer.
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For example, if the IP address is 123.123.123.123, type the following address into the web
browser: http://123.123.123.123.

TIP: After opening the embedded web server, bookmark it so that you can return to it quickly.

TIP: If you are using the Safari web browser in Mac OS X, you can also use the Bonjour
bookmark to open the EWS without typing the IP address. To use the Bonjour bookmark, open
Safari, and then from the Safari menu, click Preferences. On the Bookmarks tab, in the
Bookmarks bar section, select Include Bonjour, and then close the window. Click the Bonjour
bookmark, and then select your networked device to open the EWS.
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E How do I?

● Get started on page 1

● Change basic network settings on page 140

● Use HP ePrint on page 39

● Work with ink cartridges on page 41

● Maintain the printer on page 18
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F Errors (Windows)

● Low on ink

● Cartridge Problem

● Replace the ink cartridge

● Paper Mismatch

● The cartridge cradle cannot move

● Paper Jam

● The printer is out of paper

● Printer Offline

● Printer Paused

● Document failed to print

● Printer failure

● Door or cover open

● Previously used ink cartridge installed

● Ink cartridges depleted

● Ink cartridge failure

● Printer supply upgrade

● Printer supply upgrade successful

● Printer supply upgrade problem

● Non-HP ink cartridges installed

● Using Original HP Cartridges has its Rewards

● Counterfeit Cartridge Advisory

● Used, Refilled or Counterfeit Cartridge Detected

● Use SETUP cartridges

● Do not use SETUP cartridges
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● Not enough ink at startup

● Use black ink only?

● Use color ink only?

● Incompatible ink cartridges

● Unable to Communicate with Printer

● Ink sensor failure

● Ink sensor warning

● Problem with printer preparation

● Color cartridge out of ink

● Black cartridge out of ink

● Problem with ink system
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Low on ink
The ink cartridge identified in the message is low on ink.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low ink warning message, consider having a replacement cartridge available to avoid possible
printing delays. You do not need to replace cartridges until prompted to do so.

For information about replacing ink cartridges, see Replace the ink cartridges on page 45. For
information about ordering ink cartridges, see Order printing supplies online on page 137. For
information about recycling used ink supplies, see HP inkjet supplies recycling program on page 121.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways,
including in the initialization process, which prepares the printer and cartridges for printing. In
addition, some residual ink is left in the cartridge after it is used. For more information, see
www.hp.com/go/inkusage.
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Cartridge Problem
The ink cartridge identified in the message is missing, damaged, incompatible, or inserted into the
wrong slot in the printer.

NOTE: If the cartridge is identified in the message as incompatible, see Order printing supplies
online on page 137 for information about obtaining cartridges for the printer.

To solve this problem, try the following solutions. Solutions are listed in order, with the most likely
solution first. If the first solution does not solve the problem, continue trying the remaining solutions
until the issue is resolved.

● Solution 1: Turn the printer off and on

● Solution 2: Install the ink cartridges correctly

● Solution 3: Replace the ink cartridge

Solution 1: Turn the printer off and on

Turn off the printer, and then turn it on again.

If the problem persists, try the next solution.

Solution 2: Install the ink cartridges correctly

Make sure all of the ink cartridges are properly installed:

1. Gently pull open the ink cartridge access door.

2. Remove the ink cartridge by pushing it in to release it, and then pulling it firmly toward you.

3. Insert the cartridge into the slot. Press firmly on the cartridge to ensure proper contact.

4. Close the ink cartridge access door and check if the error message has gone away.
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Replace the ink cartridge
Replace the indicated ink cartridge. For more information, see Replace the ink cartridges on page 45.

NOTE: If your cartridge is still under warranty, contact HP support for service or replacement. For
more information about ink cartridge warranty, see ink cartridge warranty information. If the problem
persists after you replace the cartridge, contact HP support. For more information, see HP support
on page 50.
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Paper Mismatch
The paper size or type selected in the printer driver does not match the paper loaded in the printer.
Make sure that the correct paper is loaded in the printer, and then print the document again. For more
information, see Load paper on page 11.

NOTE: If the paper loaded in the printer is the correct size, change the selected paper size in the
printer driver, and then print the document again.
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The cartridge cradle cannot move
Something is blocking the ink cartridge cradle (the part of the printer that holds the ink cartridges).

To clear the obstruction, press the  (Power) button to turn off the printer, and then check the printer
for jams.

For more information, see Clear jams on page 90.
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Paper Jam
Paper has become jammed in the printer.

Before you try to clear the jam, check the following:

● Make sure that you have loaded paper that meets specifications and is not wrinkled, folded, or
damaged.

● Make sure that the printer is clean.

● Make sure that the trays are loaded correctly and are not too full. For more information, see
Load paper on page 11.

For instructions on clearing jams, as well as more information about how to avoid jams, see Clear
jams on page 90.
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The printer is out of paper
The default tray is empty.

Load more paper. For more information, see Load paper on page 11.
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Printer Offline
The printer is currently offline. While offline, the printer cannot be used.

To change the printer's status, complete the following steps.

1. Click Start, and then click Printers, Printers and Faxes, or Devices and Printers.

- Or -

Click Start, click Control Panel, and then double-click Printers.

- Or -

On the Start screen, click Control Panel, and then click View devices and printers.

2. If the printers listed in the dialog box are not being displayed in Details view, click the View
menu, and then click Details.

3. If the printer is Offline, right-click the printer, and click Use Printer Online.

4. Try using the printer again.
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Printer Paused
The printer is currently paused. While paused, new jobs are added to the queue but are not printed.

To change the printer's status, complete the following steps.

1. Click Start, and then click Printers, Printers and Faxes, or Devices and Printers.

- Or -

Click Start, click Control Panel, and then double-click Printers.

- Or -

On the Start screen, click Control Panel, and then click View devices and printers.

2. If the printers listed in the dialog box are not being displayed in Details view, click the View
menu, and then click Details.

3. If the printer is paused, right-click the printer, and click Resume Printing.

4. Try using the printer again.
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Document failed to print
The printer could not print the document because a problem occurred in the printing system.

For information about solving printing problems, see Solve printer problems on page 54.
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Printer failure
There was a problem with the printer. Usually, you can resolve such problems by completing the
following steps:

1. Press the  (Power) button to turn off the printer.

2. Unplug the power cord, and then plug in the power cord again.

3. Press the  (Power) button to turn on the printer.

If this problem persists, write down the error code provided in the message, and then contact HP
support. For more information, see HP support on page 50.
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Door or cover open
Before the printer can print documents, all doors and covers must be closed.

TIP: When completely closed, most doors and covers snap into place.

If the problem persists after you’ve securely closed all doors and covers, contact HP support. For
more information, see HP support on page 50.
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Previously used ink cartridge installed
The ink cartridge identified in the message was previously used in a different printer.

You can use ink cartridges in different printers, but if the cartridge was left outside of a printer for an
extended period of time, the print quality of your documents might be affected. Also, if you use ink
cartridges that have been used in a different printer, the ink level indicator might be inaccurate or
unavailable.

If the print quality is unsatisfactory, try cleaning the printheads. For more information, see Clean the
printhead on page 86.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways,
including in the initialization process, which prepares the printer and cartridges for printing, and in
printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some
residual ink is left in the cartridge after it is used. For more information, see www.hp.com/go/
inkusage.

For more information, see Supplies on page 138.
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Ink cartridges depleted
The cartridges listed in the message must be replaced to resume printing. HP recommends that you
do not remove an ink cartridge until a replacement is ready to install.

See Replace the ink cartridges on page 45
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Ink cartridge failure
The cartridges listed in the message are damaged or have failed.

See Replace the ink cartridges on page 45
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Printer supply upgrade
The cartridge listed in the message can only be used to upgrade one printer. Click OK to use it on this
printer. If you do not wish to proceed with the supply upgrade for this printer, click Cancel Print and
then remove the cartridge.
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Printer supply upgrade successful
The supply upgrade was successful. The cartridges listed in the message can now be used in the
printer.
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Printer supply upgrade problem
The supply upgrade was not successful. The cartridges listed in the message can still be used in this
printer. Replace the Supply Upgrade cartridge. For more information, see Replace the ink cartridges
on page 45.
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Non-HP ink cartridges installed
HP cannot guarantee the quality or reliability of non-HP supplies. Printer service or repairs required
as a result of using a non-HP supply will not be covered under warranty. If you believe you purchased
original HP ink cartridges, visit HP at www.hp.com/go/anticounterfeit for more information or to report
fraud.
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Using Original HP Cartridges has its Rewards
HP rewards loyal customers for using original HP supplies. Click the button below the message to
view Rewards online. Reward may not be available in all regions.
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Counterfeit Cartridge Advisory
The installed cartridge is not a new, original HP cartridge. Contact the store where this cartridge was
purchased. To report suspected fraud, visit HP at www.hp.com/go/anticounterfeit. To continue using
the cartridge, click Continue.
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Used, Refilled or Counterfeit Cartridge Detected
The original HP ink in the cartridge has been depleted. The solution for this problem is to replace the
ink cartridge or click OK to continue using the cartridge. For more information about replacing the
cartridge, see Replace the ink cartridges on page 45. HP rewards loyal customers for using original
HP supplies. Click the button below the message to view Rewards online. Rewards may not be
available in all regions.

WARNING! HP's ink cartridge warranty does not cover non-HP ink or cartridges. HP's printer
warranty does not cover repairs or service due to use of non-HP cartridges or ink. HP does not
guarantee the quality or reliability of non-HP ink. Information about non-HP ink levels will not be
available.
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Use SETUP cartridges
When you first setup the printer, you must install the cartridges that shipped in the box with the
printer. These cartridges are labeled SETUP, and they calibrate your printer before the first print job.
Failure to install the SETUP cartridges during the initial product setup causes an error. If you installed
a set of regular cartridges, remove them and install the SETUP cartridges to complete printer setup.
After printer setup is complete, the printer can use regular cartridges.

if you still receive error messages and the printer cannot complete ink system initialization, contact
HP support. For more information, see HP support on page 50.

Click here to go online for more information .
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Do not use SETUP cartridges
SETUP cartridges cannot be used after the printer has been initialized. Remove and install non-
SETUP cartridges. For more information, see Replace the ink cartridges on page 45.
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Not enough ink at startup
The used cartridges listed in the message might not have enough ink to complete one-time startup
processes.

Solution: Install new cartridges or click OK to use installed cartridges.

If startup cannot complete with installed cartridges, new cartridges will be needed. For information on
how to install new cartridges, see Replace the ink cartridges on page 45.
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Use black ink only?
The cartridges listed in the message are out of ink.

Solutions: To print in color, replace the empty cartridges. For information about how to install new
cartridges, see Replace the ink cartridges on page 45.

To temporarily print using Black ink only, click Use Black Only. The printer will replace color with
grayscale. The empty cartridges will need to be replaced soon.

CAUTION: Do not remove the empty color cartridge to print in Use Black Only mode.
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Use color ink only?
The black cartridge is out of ink.

Solutions: To temporarily replace black with color, click Use Color Only. Black will be simulated. Text
and photo quality will differ from those printed when using all cartridges. The black cartridge will need
to be replaced soon.

To print with black, replace the black ink cartridge. For information about how to install new
cartridges, see Replace the ink cartridges on page 45.

CAUTION: Do not remove the empty black cartridge to print in Use Color Only mode.
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Incompatible ink cartridges
The ink cartridge is not compatible with your printer.

Solution: Remove this cartridge immediately and replace with a compatible ink cartridge. For
information about how to install new cartridges, see Replace the ink cartridges on page 45.
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Unable to Communicate with Printer
The computer cannot communicate with the printer because one of the following events has
occurred:

● The printer has been turned off.

● The cable connecting the printer, such as a USB cable or a network (Ethernet) cable, has been
disconnected..

● If the printer is connected to a wireless network, the wireless connection has been broken.

To solve this problem, try the following solutions:

● Make sure the printer is turned on and that the  (Power button) light is on.

● Make sure the power cord and other cables are working and are firmly connected to the printer.

● Make sure the power cord is connected firmly to a functioning, alternating current (AC) power
outlet.

● If the printer is connected to a network, make sure the network is functioning properly. For more
information, see Solve Ethernet network problems on page 71.

● If the printer is connected to a wireless network, make sure the wireless network is functioning
properly. For more information, see Solve wireless problems on page 71.
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Ink sensor failure
The ink sensor has failed and the printer can no longer print.

Contact HP support. For more information, see www.hp.com/support.
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Ink sensor warning
The ink sensor is reporting an unexpected condition. This could be caused by the cartridge, or the
sensor may have failed. If the sensor has failed, it can no longer sense when your cartridges are out
of ink. Printing with an empty cartridge will cause air to enter the ink system, which causes poor print
quality. Significant amounts of ink will be used up to recover from this condition, which will deplete
much of the ink supply for all cartridges.

Solution: Click OK to continue printing or replace the cartridge. For information about how to install
new cartridges, see Replace the ink cartridges on page 45.
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Problem with printer preparation
The printer clock has failed and ink preparation may not be complete. The estimated Ink Level gauge
might be inaccurate.

Solution: Check the print quality of your print job. If it is not satisfactory, running the printhead
cleaning procedure from the toolbox might improve it. For more information, see Clean the printhead
on page 86.
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Color cartridge out of ink
The cartridges listed in the message are out of ink.

Solutions: To print in color, replace the empty cartridges. For information about how to install new
cartridges, see Replace the ink cartridges on page 45.

To temporarily print using black ink only, click Cancel Print and then re-send the print job. The Use
black ink only? message appears before the job prints. The empty cartridges will need to be replaced
soon.

CAUTION: Do not remove the empty color cartridge to print in Use Black Only mode.

192 Appendix F   Errors (Windows) ENWW



Black cartridge out of ink
The black cartridge is out of ink.

Solutions: Replace the black ink cartridge. For information about how to install new cartridges, see
Replace the ink cartridges on page 45.

To temporarily replace black with color, click Cancel Print and re-send the print job. The Use color ink
only? message appears before the job prints. The black cartridge will need to be replaced soon.

CAUTION: Do not remove the empty black cartridge to print in Use Color Only mode.
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Problem with ink system
Please remove the ink cartridges and examine them for any sign of leaks. If any cartridges have
leaks, contact HP support. Do not use cartridges that are leaking.

If there are no leaks, re-install cartridges and close the printer cover. Turn the printer off then on
again. If you get this message a second time, contact HP support.

For more information about contacting HP support, see HP support on page 50.

194 Appendix F   Errors (Windows) ENWW



Index

A
accessibility 2
accessories

installation 16
printer status report 81
turn on and off in driver 16
warranty 101

acoustic emissions 111
after the support period 52
align printhead 87

B
B sizes

sizes supported 105
blank pages, troubleshoot

print 56
both sides, print on 32
Brochures

sizes supported 107

C
capacity

trays 108
cards

sizes supported 106
tray supporting 108

cartridges. See ink cartridges
clean

exterior 18
printhead 86
scanner glass 18

Configure
firewall 68

connection type
change 145

connectors, locating 6
control panel

illustration 93
lights, understanding 93

custom-size paper
sizes supported 107

custom-sized paper
Mac OS 28
print on 28

customer support
electronic 50

cut-off pages, troubleshoot 57

D
diagnostic page 61
double-sided printing 32
driver

accessories settings 16
warranty 101

duplexer
installation 16
turn on and off in driver 16

duty cycle 104

E
electrical specifications 111
embedded web server

about 155
opening 155
troubleshoot, cannot be

opened 69
envelopes

sizes supported 106
tray supporting 108

environmental specifications 111
environmental sustainability

program 120
EWS. See embedded web server

F
Firewall

configure 68
firewalls, troubleshoot 55

fonts supported 104

G
glass, scanner

clean 18

H
head 86
HP software

uninstall from Windows 88
HP Utility (Mac OS X)

opening 154
humidity specifications 111

I
ink cartridge access door,

locating 5
Ink cartridges

warranty 101
ink cartridges 6

check ink levels 43
lights 93
locating 5
ordering online 137
part numbers 138
replace 45
supported 103
tips 42
yields 104

ink delivery
expiration dates 82
part numbers 82
status 82

ink levels, check 43
input tray

capacity 108
paper sizes supported 105
paper types and weights

supported 108

ENWW Index 195



installation
accessories 16
duplexer 16
hardware installation

suggestions 79
HP software installation

suggestions 79
troubleshooting issues 79

IP address
checking for printer 69

IP settings 141

J
jams

clear 90
paper 90, 91
paper to avoid 10

L
language, printer 104
lights on control panel

illustration 93
understanding 93

lights reference 93
link speed, setting 141

M
Mac OS 22

custom-sized paper 28
Print borderless 30
Print photos 26
print settings 21
turn accessories on and off in

driver 16
Mac OS X

HP Utility 154
maintain

printhead 86
maintenance

align printhead 87
check ink levels 43
clean printhead 86
diagnostic page 61
print quality report 61
printhead 86
replace ink cartridges 45

margins
setting, specifications 108

media
duplexing 32
print on custom-sized 28

memory
specifications 104

missing or incorrect information,
troubleshoot 57

model number 81
multi-feeds, troubleshoot 65

N
networks

advanced settings 141
connector illustration 6
firewalls, troubleshoot 55
IP settings 141
link speed 141
settings, change 140
solve problems 71
view and print settings 140
wireless communication

setup 143
wireless settings 83

noise information 111

O
operating environment

specifications 111
operating systems supported 104
output tray

locating 5
paper supported 108

P
pages per month (duty cycle) 104
paper

clear jams 90
HP, order 138
jams 90, 91
load tray 11
selecting 10
skewed pages 64
specifications 105
supported sizes 105
troubleshoot feeding 64
types and weights supported

108
paper-feed problems,

troubleshoot 64
PCL 3 support 104
phone support 50
phone support period

period for support 51

photo paper
sizes supported 107

ports, specifications 103
power

specifications 111
troubleshoot 54

power input, locating 6
print

diagnostic page 61
double-sided 32
print quality report 61
printer status report 81
troubleshoot 54

Print borderless
Mac OS 30
Windows 30

Print brochures
print 22

Print envelope 24
Print envelopes

Mac OS 24
Print photos

Mac OS 26
Windows 26

print quality report 61
print settings

print quality 59
printer control panel

locating 5
network settings 140

printer driver
accessories settings 16
warranty 101

printer software (Windows)
opening 19

printer status report
information on 81
print 81

printhead
clean 86

printhead, align 87
printheads

lights 93
ordering online 137
supported 103

printing
slow, troubleshoot 55

processor specifications 104

196 Index ENWW



R
radio interference

reducing 148
regulatory information 116

radio, turn off 140
rear access panel

clear jams 90
illustration 6

recycle
ink cartridges 121

regulatory information 113, 116
regulatory model number 113
replace ink cartridges 45
report

wireless test 147
reports

diagnostic 61
print quality 61
printhead 86

S
scanner glass

clean 18
security

wireless communication 147
serial number 81
settings

network 140
skew, troubleshoot

print 64
software

accessories settings 16
warranty 101

sound pressure 111
specifications

acoustic emissions 111
electrical 111
operating environment 111
paper 105
physical 103
processor and memory 104
storage environment 111
system requirements 104

status
network configuration page 83
printer status report 81

storage environment
specifications 111

supplies
ordering online 137

printer status report 81
yields 104

support 50
system requirements 104

T
temperature specifications 111
text

troubleshoot 57
Toolbox (Windows)

about 153
opening 153

tray 2
turn on and off in driver 16

trays
capacities 108
clear jams 90
load paper 11
locating 5
paper guides illustration 5
paper sizes supported 105
paper types and weights

supported 108
troubleshoot feeding 64
turn on and off in driver 16

troubleshoot
blank pages printed 56
cut-off pages, incorrect text or

graphics placement 57
embedded web server 69
firewalls 55
jams, paper 91
missing or incorrect

information 57
multiple pages are picked 65
network configuration page 83
nothing prints 54
paper not picked up from tray

64
paper-feed problems 64
power 54
print 54
printer status report 81
skewed pages 64
tips 53

troubleshooting
Ethernet network 71
hardware installation

suggestions 79

HP software installation
suggestions 79

installation issues 79
lights 93
solve network problems 71
wireless problems 71

two-sided printing 32

U
uninstall HP software

Windows 88
USB connection

port, locating 5, 6
specifications 103

V
view

network settings 140
voltage specifications 111

W
warranty 101
websites

accessibility information 2
customer support 50
environmental programs 120
order supplies and

accessories 136
supply yield data sheet 104

Windows 24
borderless 30
print brochures 22
Print photos 26
print settings 21
system requirements 104
turn accessories on and off in

driver 16
uninstall HP software 88

wireless communication
advanced wireless

troubleshooting 73
basic wireless

troubleshooting 72
radio, turn off 140
reducing interference 148
regulatory information 116
security 147
set up 143

wireless test report
print 147

ENWW Index 197



198 Index ENWW






	Get started
	Accessibility
	HP EcoSolutions (HP and the Environment)
	Manage Power
	Optimize Printing Supplies

	Understand the printer parts
	Front view
	Printing supplies area
	Control panel
	Back view

	Select print paper
	Recommended papers for printing
	Recommended papers for photo printing
	Tips for selecting and using paper

	Load paper
	Load standard-size paper
	Load envelopes
	Load cards and photo paper
	Load custom-size paper

	Turn the printer off
	Update the printer
	Install the accessories
	Install the automatic two-sided printing accessory (duplexer)
	Turn on accessories in the printer driver
	To turn on accessories (Windows)
	To turn on accessories on (Mac OS X)


	Maintain the printer
	Clean the exterior
	Restore factory defaults

	Open the HP printer software (Windows)

	Print
	Print documents
	Print documents (Windows)
	Print documents (Mac OS X)

	Print brochures
	Print brochures (Windows)
	Print brochures (Mac OS X)

	Print on envelopes
	Print on envelopes (Windows)
	Print on envelopes (Mac OS X)

	Print photos
	Print photos on photo paper (Windows)
	Print photos on photo paper (Mac OS X)

	Print on special and custom-sized paper
	Print on special or custom-sized paper (Mac OS X)
	Set up custom sizes (Mac OS X)

	Print borderless documents or photos
	Print borderless documents or photos (Windows)
	Print borderless documents or photos (Mac OS X)

	Print on both sides (duplexing)
	Perform two-sided printing (Windows)
	Perform two-sided printing (Mac OS X)

	Tips for print success

	HP ePrint
	Set up HP ePrint
	Set up HP ePrint using the embedded web server
	Set up HP ePrint using the HP printer software

	Use HP ePrint
	Print using HP ePrint
	Find the printer's email address
	Turn off HP ePrint

	Remove Web Services

	Work with ink cartridges
	Information on ink cartridges and the printhead
	Check the estimated ink levels
	Printing with black or color ink only
	Replace the ink cartridges
	Store printing supplies
	Anonymous usage information storage

	Solve a problem
	HP support
	Obtain electronic support
	HP support by phone
	Before you call
	Phone support period
	Telephone support numbers
	After the phone support period


	General troubleshooting tips and resources
	Solve printer problems
	The printer shuts down unexpectedly
	Alignment fails
	The printer is not responding (nothing prints)
	The printer prints slowly
	Solution 1: Use a lower print quality setting
	Solution 2: Check the ink levels
	Solution 3: Contact HP support

	The printer is making some unexpected noises
	Blank or partial page printed
	Something on the page is missing or incorrect
	Placement of the text or graphics is wrong

	Print quality troubleshooting
	Solution 1: Make sure you are using original HP ink cartridges
	Solution 2: Check the ink levels
	Solution 3: Check the paper loaded in the input tray
	Solution 4: Check the paper type
	Solution 5: Check the print settings
	Solution 6: Print and evaluate a print quality report
	Solution 7: Contact HP support

	Solve paper-feed problems
	Solve problems using HP ePrint and HP websites
	Solve problems using HP ePrint
	Solve problems using HP websites

	Configure your firewall software to work with the printer
	Solve printer management problems
	Embedded web server cannot be opened

	Solve network problems
	Solve Ethernet network problems
	Solve wireless problems
	Basic wireless troubleshooting
	Advanced wireless troubleshooting
	Step 1: Make sure your computer is connected to your network
	Step 2: Make sure that the printer is connected to your network
	Step 3: Make sure your computer is not connected over a Virtual Private Network (VPN)
	Step 4: Make sure the printer is online and ready
	Step 5: Make sure the HP printer labeled (Network) is set as the default printer driver (Windows onl ...
	Step 6: Check to see if the firewall software is blocking communication

	After resolving the problems

	Reset the Printer Network Settings

	Troubleshoot installation issues
	Hardware installation suggestions
	HP software installation suggestions

	Understand the Printer Status Report
	Understand the network configuration page
	Printhead maintenance
	Clean the printhead
	Align the printhead

	Uninstall and reinstall the HP software
	Clear jams
	Clear paper jams
	Avoid paper jams

	Control panel lights reference

	Technical information
	Warranty information
	Hewlett-Packard limited warranty statement
	Ink cartridge warranty information

	Printer specifications
	Physical specifications
	Product features and capacities
	Processor and memory specifications
	System requirements
	Network protocol specifications
	Embedded web server specifications
	Paper specifications
	Understand specifications for supported paper
	Understand supported sizes
	Understand supported paper types and weights

	Set minimum margins
	Guidelines for printing on both sides of a page

	Print resolution
	HP ePrint and HP website specifications
	HP ePrint specifications
	HP website specifications

	Environmental specifications
	Electrical specifications
	Acoustic emission specifications

	Regulatory information
	Regulatory model number
	FCC statement
	Notice to users in Korea
	VCCI (Class B) compliance statement for users in Japan
	Notice to users in Japan about the power cord
	Noise emission statement for Germany
	GS Declaration (Germany)
	European Union Regulatory Notice
	Regulatory information for wireless products
	Exposure to radio frequency radiation
	Notice to users in Brazil
	Notice to users in Canada
	Notice to users in Taiwan
	Notice to users in Mexico
	Notice to users in Japan


	Environmental product stewardship program
	Paper use
	Plastics
	Material safety data sheets
	Recycling program
	HP inkjet supplies recycling program
	Disposal of waste equipment by users in private households in the European Union
	Power consumption
	Chemical Substances
	Battery information
	Battery disposal in Taiwan
	Attention California users
	Battery disposal in the Netherlands

	RoHS notices (China only)
	RoHS notices (Ukraine only)

	Third-party licenses

	HP supplies and accessories
	Order printing supplies online
	Supplies
	Ink cartridges
	HP paper


	Network setup
	Change basic network settings
	View and print network settings
	Turn the wireless radio on and off

	Change advanced network settings
	Set link speed
	View IP settings
	Change IP settings
	Reset network settings

	Set up the printer for wireless communication
	Before you begin
	Set up the printer on your wireless network
	Set up the printer using the HP printer software
	Set up the printer using WiFi Protected Setup (WPS)
	Set up the printer using the embedded web server (EWS)

	Change the connection type
	To change from an Ethernet connection to a wireless connection
	To change from a USB connection to a wireless connection
	To change from a wireless connection to a USB or Ethernet connection

	Test the wireless connection
	Guidelines for ensuring wireless network security
	Overview of security settings
	Add hardware addresses to a wireless router (MAC filtering)
	To add hard addresses to a wireless router or wireless access point

	Other wireless security guidelines

	Guidelines for reducing interference on a wireless network

	HP wireless direct printing
	Turn on HP wireless direct printing
	Print from a wireless-capable mobile device
	Print from a wireless-capable computer
	Print from a wireless-capable computer (Windows)
	Print from a wireless-capable computer (Mac OS X)



	Printer management tools
	Toolbox (Windows)
	Open the Toolbox

	HP Utility (Mac OS X)
	To open HP Utility

	Embedded web server
	About cookies
	To open the embedded web server


	How do I?
	Errors (Windows)
	Low on ink
	Cartridge Problem
	Replace the ink cartridge
	Paper Mismatch
	The cartridge cradle cannot move
	Paper Jam
	The printer is out of paper
	Printer Offline
	Printer Paused
	Document failed to print
	Printer failure
	Door or cover open
	Previously used ink cartridge installed
	Ink cartridges depleted
	Ink cartridge failure
	Printer supply upgrade
	Printer supply upgrade successful
	Printer supply upgrade problem
	Non-HP ink cartridges installed
	Using Original HP Cartridges has its Rewards
	Counterfeit Cartridge Advisory
	Used, Refilled or Counterfeit Cartridge Detected
	Use SETUP cartridges
	Do not use SETUP cartridges
	Not enough ink at startup
	Use black ink only?
	Use color ink only?
	Incompatible ink cartridges
	Unable to Communicate with Printer
	Ink sensor failure
	Ink sensor warning
	Problem with printer preparation
	Color cartridge out of ink
	Black cartridge out of ink
	Problem with ink system

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Remove
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /Courier-Oblique
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Oblique
    /Symbol
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /ZapfDingbats
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.33333
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /SyntheticBoldness 1.000000
  /Description <<
    /ENU (FOR Acrobat 8 HPIE Screen Optimized PDF- Version 2 Compatible with Screenshots under 225 dpi)
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


